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Before You Begin
This section provides you with safety information, technical support 
information, and sources for additional product information.

Safety Information 
Your safety is extremely important. Read and follow all warnings and 
cautions in this document before handling and operating Intermec 
equipment. You can be seriously injured, and equipment and data can 
be damaged if you do not follow the safety warnings and cautions.

This section explains how to identify and understand warnings, 
cautions, and notes that are in this document.   

Global Services and Support
Warranty Information
To understand the warranty for your Intermec product, visit the 
Intermec web site at www.intermec.com and click Support > 
Returns and Repairs > Warranty.

A warning alerts you of an operating procedure, practice, 
condition, or statement that must be strictly observed to avoid 
death or serious injury to the persons working on the 
equipment.

A caution alerts you to an operating procedure, practice, 
condition, or statement that must be strictly observed to prevent 
equipment damage or destruction, or corruption or loss of data.

Note: Notes either provide extra information about a topic or 
contain special instructions for handling a particular condition or 
set of circumstances.

http://www.intermec.com
http://www.intermec.com
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Disclaimer of warranties: The sample code included in this document 
is presented for reference only. The code does not necessarily 
represent complete, tested programs. The code is provided “as is with 
all faults.” All warranties are expressly disclaimed, including the 
implied warranties of merchantability and fitness for a particular 
purpose.

Web Support
Visit the Intermec web site at www.intermec.com to download our 
current manuals (in PDF). 

Visit the Intermec technical knowledge base (Knowledge Central) at 
www.intermec.com and click Support > Knowledge Central to 
review technical information or to request technical support for your 
Intermec product.

Telephone Support
In the U.S.A. and Canada, call 1-800-755-5505. 

Outside the U.S.A. and Canada, contact your local Intermec 
representative. To search for your local representative, from the 
Intermec web site, click About Us > Contact Us.

Service Location Support
For the most current listing of service locations, click Support 
>Returns and Repairs > Repair Locations.

For technical support in South Korea, use the after service locations 
listed below:

AWOO Systems
102-1304 SK Ventium
522 Dangjung-dong
Gunpo-si, Gyeonggi-do Korea, South 435-776
Contact: Mr. Sinbum Kang
Telephone: +82-31-436-1191
E-mail: mjyun@awoo.co.kr

http://www.intermec.com
http://www.intermec.com
http://www.intermec.com
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IN Information System PTD LTD
6th Floor
Daegu Venture Center Bldg 95
Shinchun 3 Dong
Donggu, Daegu City, Korea
E-mail: jmyou@idif.co.kr or korlim@gw.idif.co.kr

Who Should Read This Manual
This manual is for the person who is responsible for installing, 
configuring, and maintaining the CK3 Mobile Computer. In this 
manual, CK3 refers to models CK3a, CK3a1, CK3n, CK3n1, and 
CK3NI, unless specifically stated otherwise. 

This manual provides you with information about the features of the 
CK3, including how to install, configure, operate, maintain, and 
troubleshoot it.

Before you work with the CK3, you should be familiar with your 
network and general networking terms, such as IP address.

Related Documents
The Intermec web site at www.intermec.com contains our 
documents (as PDF files) that you can download for free.

To download documents
1 Visit the Intermec web site at www.intermec.com.

2 Click the Products tab.

3 Using the Products menu, navigate to your product page. For 
example, to find the CK3 computer product page, click 
Computers > Handheld Computers > CK3.

4 Click the Manuals tab.

If your product does not have its own product page, click Support > 
Manuals. Use the Product Category field, the Product Family field, 
and the Product field to help you locate the documentation for your 
product.

http://www.intermec.com
http://www.intermec.com
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Patent Information
Product is covered by one or more of the following patents: 

4953113; 4961043; 4970379; 4988852; 5019699; 5021642; 5038024; 
5081343; 5095197; 5144119; 5144121; 5182441; 5187355; 5187356; 
5195183; 5216233; 5216550; 5218191; 5227614; 5233172; 5241488; 
5243602; 5258606; 5278487; 5288985; 5308966; 5322991; 5331136; 
5331580; 5342210; 5349678; 5359185; 5371858; 5373458; 5389770; 
5397885; 5410141; 5414251; 5416463; 5442167; 5464972; 5468947; 
5468950; 5477044; 5486689; 5488575; 5500516; 5502297; 5504367; 
5508599; 5514858; 5530619; 5534684; 5536924; 5539191; 5541419; 
5548108; 5550362; 5550364; 5565669; 5567925; 5568645; 5572007; 
5576529; 5592512; 5594230; 5598007; 5608578; 5616909; 5619027; 
5627360; 5640001; 5657317; 5659431; 5671436; 5672860; 5684290; 
5719678; 5729003; 5742041; 5761219; 5764798; 5777308; 5777309; 
5777310; 5786583; 5793604; 5798509; 5798513; 5804805; 5805807; 
5811776; 5811777; 5818027; 5821523; 5828052; 5831819; 5834749; 
5834753; 5837987; 5841121; 5842070; 5844222; 5854478; 5862267; 
5869840; 5873070; 5877486; 5878395; 5883492; 5883493; 5886338; 
5889386; 5892971; 5895906; 5898162; 5902987; 5902988; 5912452; 
5923022; 5936224; 5949056; 5969321; 5969326; 5969328; 5979768; 
5986435; 5987192; 5987499; 5992750; 6003775; 6012640; 6016960; 
6018597; 6024289; 6034379; 6036093; 6039252; 6064763; 6075340; 
6095422; 6097839; 6102289; 6102295; 6109528; 6119941; 6128414; 
6138915; 6149061; 6149063; 6152370; 6155490; 6158661; 6164542; 
6164545; 6173893; 6195053; 6234393; 6234395; 6244512; 6249008; 
6328214; 6330975; 6345765; 6356949; 6367699; 6375075; 6375076; 
6375344; 6431451; 6435411; 6484944; 6488209; 6497368; 6532152; 
6538413; 6539422; 6621942; 6641046; 6681994; 6687403; 6688523; 
6732930; 6859190; 6889903; 6967280; 7027037; 7035466; 7090137; 
7121467.

Docking station or device: 5052943; 5195183; 5317691; 5331580; 
5544010; 5644471.

There may be other U.S. and foreign patents pending.
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1
Using the Computer

This chapter introduces the CK3 Mobile Computer with 
Windows® Mobile® 6.1 and contains these topics:

• Introducing the CK3 Mobile Computer

• What’s New?

• Using the Battery

• Using the Keypad

• Understanding the Audio Features

• Using the Touch Screen

• Understanding the Status LEDs

• Scanning Bar Codes

• Using a microSD Card
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Introducing the CK3 Mobile Computer
The Intermec CK3 Mobile Computer is an ergonomically designed 
mobile computer built on the Microsoft® Windows® Mobile 6.1 
operating system. The CK3 is lightweight, easy-to-use, and runs most 
software developed for the Windows Mobile platform, including 
standalone, client-server, and browser-based applications. In this 
manual, CK3 refers to models CK3a, CK3a1, CK3n, CK3n1, and 
CK3NI, unless specifically stated otherwise. 

CK3 Mobile Computer

Power button

Docking connector

Scan button

Tethered stylus

Status LEDs

The CK3a and CK3n Mobile Computer with a DHIB 802.11b/g radio 
installed is Wi-Fi® certified for interoperability with other 802.11b/g 
wireless LAN devices.

The CK3a1 and CK3n1 Mobile Computer with a DDIB 802.11a/
b/g radio installed is Wi-Fi® certified for interoperability with 
other 802.11a/b/g wireless LAN devices.
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The CK3 is available with the following features:

• 802.11b/g or 802.11a/b/g and Bluetooth® radio, standard

• 128 MB DRAM, 64 MB Flash

• 512 MB embedded SD Mass Storage Card

• Alphanumeric or numeric keypad

• Imaging options: 

• EV12 linear imager

• EA20X extended range area imager

• EX25B or EX25C near-far range area imager 

• Intermec Client Pack (Optional):

• Intermec Terminal Emulator, including 3270, 5250, and 
VT/ANSI, and support for third-party TE applications

• Intermec Browser

Use this manual to understand how to use the features and options 
available on the CK3. For information about Windows Mobile 6.1 
applications installed on the CK3, refer to the online help.

Note: The radio also supports the 802.11d standard. The 802.11d 
standard adds the requirements and definitions for 802.11 WLAN 
equipment to operate in markets not served by the current 
standard. For 802.11d support, you need to order the 802.11d 
version of the CK3. For help, contact your local Intermec 
representative.

Note: The Intermec Client Pack is not compatible with the new 
large 28-key numeric keypad option.
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What’s New?
This version of the CK3 Mobile Computer User’s Manual contains these 
enhancements:

• Corrected the connecting to a Bluetooth scanner section.

• Correct the follow appendix sections:

• EA20X Extended Range Area Imager Minimum Reading 
Distances

• Single Dock (AD20)

Using the Battery
The CK3 uses an AB17 standard or AB18 extended battery as its main 
power source. The standard battery has a 7.4 Watt hour capacity, and 
the extended battery has a 18.8 Watt hour capacity. Several factors 
determine the life of your battery, such as extreme temperatures, 
input devices, and your usage.

You must fully charge the battery before you can use the CK3. When 
you change the battery, an internal super capacitor maintains your 
status, memory, and real-time clock for approximately 10 minutes.

For replacement batteries, contact your Intermec representative. 

The battery used in this device may present a fire or chemical 
burn hazard if it is mistreated. Do not disassemble it, heat it 
above 100°C (212°F) or incinerate it. Dispose of used batteries 
promptly. Keep away from children.

If you fail to replace the low battery immediately, you may lose 
important data or applications.

Note: If the CK3 is not using external power and you remove the 
battery pack, the CK3 goes into Suspend mode.
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Charging the Battery
Make sure you fully charge the AB17 or AB18 battery before you use 
your CK3. You can charge the battery before or after you install it in 
the CK3. A fully discharged battery charges in approximately 4 (AB17) 
to 7 (AB18) hours.

To charge the battery
• Insert the battery into the battery bay of the AD20 single dock, or 

insert up to four batteries into the AC20 quad battery charger.

Or,

• Install the battery in the CK3 and insert the CK3 into the AD20 
single dock, AD21 Ethernet multidock, AD22 charge-only 
multidock, AE33 vehicle battery adapter, or AV10 vehicle dock.

Use the next table to understand how long it takes to charge your 
batteries in each of the CK3 charger or dock accessories.

Removing and Installing the Battery
To maximize the time allowed to replace the main battery pack, put 
the CK3 in suspend mode before removing the battery pack.

To remove and install the battery
1 Press and hold  for about 2 seconds. When you release , the 

CK3 goes into suspend mode.

2 If necessary, disconnect the handstrap from the bottom of the 
CK3.

Charging Times for CK3 Batteries

CK3 Charging Accessory AB17 Charging Time AB18 Charging Time

AC20 quad battery charger up to 4 hours up to 6 hours

AD20 single dock up to 4 hours up to 6 to 7 hours

AD21 Ethernet multidock up to 4 hours up to 7 hours

AD22 charge-only multidock up to 4 hours up to 7 hours

AE33 vehicle battery adapter up to 4 hours up to 7 hours

AV10 vehicle dock up to 4 hours up to 7 hours
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3 Press the battery release tab toward the battery until the battery 
releases, and then lift it away from the CK3.

4 Insert the battery into the CK3, and press down on the battery 
until it clicks into place.

Maximizing Battery Life
Batteries are chemical devices. If the batteries are left sitting on a shelf 
for long periods of time outside the CK3, the batteries slowly 
discharge, eventually to zero if left uncharged. The battery chemistry 
resists normal degradation if you store the battery in a charger as 
opposed to leaving the battery in a discharged state. See the following 
table for tips to maximize the life of your battery.

Battery Conservation Tips

When You Want To: Do This to Save Battery Power:

Operate the CK3 and the 
Low Battery status icon 
appears or the Battery LED 
comes on.

Press  to turn off the CK3. Remove the 
battery and insert another fully charged 
battery within 10 minutes or you may lose 
data. Or, you can connect the CK3 to an 
external power source.

Stop using the CK3 for 5 
minutes or longer.

Make sure the low battery icon is not on the 
screen and that the Battery LED is not turned 
on. Press  to turn off the CK3.

Store the CK3 for more 
than a day.

If you are storing the CK3 for a few days, like 
over the weekend, install the charged battery 
or attach the CK3 to a power source.
If you are storing the CK3 for longer, remove 
and charge the battery, then store both the 
battery and the CK3 in a cool location.
If the battery in storage is not used in several 
months, you should recharge the battery to 
keep it at its performance peak.

Store the battery outside the 
CK3.

Store the batteries in a charger.
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Checking the Battery Status
The easiest way to check the status of your battery is to look at the 
battery icon on the status bar of your CK3. 

The Battery Status LED below your CK3 display indicates the 
charging status of your battery.

Battery Icon Status

Icon Status

Battery is fully charged.

Battery has a medium charge. You should be able to work for several 
more hours before changing batteries.

Battery is low. You need to replace the battery soon.

Battery is critically low. You need to replace the battery now.

Battery is charging.

Understanding the Battery Status LED 

 LED State Description

Steady green when the CK3 is 
connected to external power

The battery is more than 95% charged.

Blinking red The battery is low. CK3 goes into Suspend 
mode. Charge or replace the battery.

Steady red when the CK3 is 
connected to external power

The battery is charging.

Steady red when the CK3 is not 
connected to external power

The software is not working properly.

Steady amber The battery is missing or is unable to 
charge because the temperature is outside 
of the charging range.

Off The CK3 is not on external power and the 
battery is operating normally.
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Using the Keypad
Use the following sections to understand how to use the keypad. For 
information on remapping the keypad, you can download the Device 
IDL Resource Kit from the Intermec web site at www.intermec.com/
idl.

The CK3 comes with an alphanumeric keypad, a numeric keypad, or a 
large 28-key numeric keypad.

CK3 Alphanumeric Keypad CK3 Numeric Keypad

http://www.intermec.com/idl
http://www.intermec.com/idl
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CK3 Large 28-Key Numeric Keypad

The full alphabetic keypad is designed for applications that require 
primary input of alphabetic data. This keypad also provides special 
characters, numbers, symbols, and functions by pressing color-coded 
key sequences.

The numeric keypad is for applications that require mainly numeric 
data. This keypad also lets you enter special characters, including the 
alphabet, by pressing color-coded key sequences. 

The large numeric 28-key keypad is for browser-based applications 
that require heavy usage of numeric and navigation keys. This keypad 
also provides function keys by pressing color-coded key sequences. 

Using the Color-Coded Keys
Each keypad provides color-coded keys to let you access additional 
characters, symbols, and functions printed on the keypad overlay. 
Once you understand how to use the color-coded keys and key 
sequences, you can access all of the additional features printed on the 
keypad overlay. 

F1 F2 F3

F4 F5 F6

F7 F8 F9

F10
7 98

4 6

1 32

Enter0.

5

Esc Action
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There are two color-coded modifier keys: the orange  key and the 
green  key. 

Capitalizing Characters
You can capitalize characters individually, or you can type all capital 
letters by enabling Caps Lock.

To capitalize a single character
• On the alphanumeric keypad, press the  key, and then the  

key to select the Shift function. Press the  key, and the 
character. 

• On the numeric keypad, press the  key, and then the key to 
select the Shift function.

To enable Caps Lock
• On the alphanumeric keypad, press , then the  key. Press  

again to disable the Caps Lock.

• On the numeric keypad, press  .

Note: The large numeric keypad does not support alpha characters. 
However, you can remap keys and access them with the orange or 
green color-coded keys. To remap keys, you need the Device Resource 
Kit which is part of IDL. For help, go to www.intermec.com/idl.

Using the Color-Coded Keys

You Want to: Press: Example

Use an orange character or 
function printed above a key.

 key (LED turns on) and 
then the key with the character 
or function printed above it 
(LED stays on).

On the CK3 alphanumeric 
keypad, press  and then  
to select the F18 function.

Use a green character or 
function printed above a key.

 key (LED turns on) and 
then the key with the character 
or function printed above it 
(LED stays on).

On the CK3 alphanumeric 
keypad, press  and then 

 to select the ok function.

Unlock the green or orange key.  or  once. Press  or  once to 
unlock the key. The LED turns 
off.
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The Caps Lock LED lights up green to show that the CK3 is in the 
Caps Lock mode.

To disable Caps Lock
• Press the color modifier key again.

For information on how to enter specific characters with keystrokes, 
see “Keypads and Keystrokes” on page 107.

Using the Power Button
When you press the Power button ( ), you put the CK3 into suspend 
mode. In this lower power mode, the CK3 continues to supply power 
to all memory, but turns off power to most hardware such as the 
display. This power-saving feature is designed to prolong battery life.

When you press  to turn the CK3 back on, your computer resumes 
at the screen that was displayed when you turned it off. If you are 
using WPA or 802.1x security, the CK3 may need to reauthenticate 
before it resumes your application.

If the battery light flashes and your CK3 does not resume after 
pressing , your battery may be too low to supply power. Replace the 
battery. If replacing the battery does not solve the problem, see 
“Resetting the CK3” on page 77.

Configuring the Backlight Settings
By default, the CK3 goes into Screen Off mode when there is no 
activity on the computer. Screen Off mode turns off the backlight and 
display. Press a key or tap the screen to resume activity.

To configure the backlight
1 Tap Start > Settings > the System tab > the Backlight icon > the 

Battery Power tab.

2 With Turn off backlight if device is not used for checked, select 
the timeout value (10 seconds, 30 seconds, or 1 to 5 minutes).

You can also use Intermec Settings to configure the backlight 
settings.
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Understanding the Audio Features
The CK3 has a speaker, a microphone, and multiple software tools for 
configuring the volume of sounds.

Adjusting the Volume of the Speaker
You can adjust the computer volume for your needs and your 
environment. The volume includes sounds you hear when you tap the 
screen or scan bar codes with a scanner. You can set the volume to off, 
very low, low, medium, high, and very high (default). 

To adjust the volume of the speaker with the Volume icon
1 Tap the Volume ( ) icon at the top of the screen.

2 Use your stylus to adjust the volume slider.

You can also use Intermec Settings to adjust the volume.

Using the Push To Talk (PTT) Feature
You can use the PTT feature to:

• record audio on your CK3.

• use your CK3 as a two-way radio.

Recording Audio on Your CK3
You can use the PTT key in the upper right corner of the keypad to 
automatically record audio on your CK3. What happens when you 
press the PTT key depends on whether your CK3 is on or is in suspend 
mode:

• If your CK3 is on:

• Press the PTT key to start the Note application in audio note 
mode.

• Press and hold the PTT key to start the Note application in 
audio note mode and start recording. You can record using the 
internal microphone or a headset microphone attached to the 
CK3 through the AA20 audio adapter. To stop recording, 
release the PTT button.

• If your CK3 is in suspend mode:
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• Press the PTT key to turn on CK3.

• Press and hold the PTT key for about 2 seconds to turn on the 
CK3 and start the Note application in audio note mode.

• Press and hold the PTT key for more than 2 seconds to turn on 
the CK3, start the Note application in audio note mode, and 
start recording. You can record using the internal microphone 
or a headset microphone attached to the CK3 through the 
AA20 or 1007AA01 audio adapter. To stop recording, release 
the PTT key.

To order the AA20 or 1007AA01 audio adapter, contact your local 
Intermec representative.

Using Your CK3 as a Two-Way Radio
You can also use the PTT feature with audio applications, such as 
iTalkie™ to communicate between two or more CK3s over the 802.11 
radio network. You press the PTT button to talk to another CK3.

For more information, go to www.tabletmedia.com/iTalkie.html.

Using the Touch Screen
The CK3 has a 240 x 320 pixel color touch screen display. The 
Windows Mobile 6.1 start screen has three distinct areas: the 
navigation bar, today screen, and command bar.

Windows Mobile 6.1 Start Screen

Navigation bar

Today screen

Command bar

http://www.tabletmedia.com/iTalkie.html
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To turn the screen backlight on and off
• For the alphanumeric keypad, press  .

• For the numeric keypad, press 

Using the Stylus
Your computer has a stylus for selecting items and entering 
information on the touch screen.

Understanding the Screen Icons
Use the screen icons on the navigation bar and the command bar to 
see the network connection status and other system information. For 
information about the battery icons, see “Checking the Battery 
Status” on page 7. Some standard Microsoft icons are included in 
this table.

Functions You Can Perform With the Stylus

Action Description

Tap Touch the screen once with the stylus to select options, 
open or close applications, or launch menus from the 
Command bar.

Drag Hold the stylus on the screen and drag across the screen to 
select text and images.

Tap and hold Tap and hold the stylus on an item to see a menu of 
actions available for that item. On the pop-up menu that 
appears, tap the action you want to perform.

Screen Icons

Icon Description

The volume is turned off. To turn the volume back on, tap this icon 
and choose your setting.

The computer is connected to the network.

The computer is not connected to the network.

The 802.11 radio is connected to the wireless network.
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Aligning the Touch Screen
If the touch screen does not respond when you tap it with the stylus, 
you may need to calibrate the screen.

To calibrate the touch screen
1 Tap Start > Settings > the Systems tab > Screen.

2 Tap Align Screen and follow the instructions to align the screen.

3 Click ok.

To align the touch screen using the keypad
1 Access the Start menu by pressing  .

2 Press the Down button to select Settings.

3 Press Enter.

4 Press the Tab button until the Settings tabs are highlighted.

5 Press the Right Arrow button to select the System tab.

6 Press Tab until the Screen icon is highlighted.

7 Tab to Align Screen and press Enter. 

8 Follow the instructions to align the screen.

9 Click ok.

If you are still unable to align the touch screen, you can clean boot the 
CK3. For help, see “Clean Booting the CK3” on page 78.

The computer is connected through the USB port to your desktop 
PC.

The iConnect application icon. Tap it to set up Ethernet or Wireless 
settings.

Screen Icons (continued)

Icon Description

Note: If the touch screen is so out of alignment that you cannot 
open the Start menu, you can try to align the screen menu using 
the keypad. For help, see the next procedure.
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Understanding the Status LEDs
The CK3 has three status LEDs.

Location of the Status LEDs

The next table describes the Notification LED, Good Read LED, and 
Intermec Ready-to-Work™ indicator. For information about the 
battery status LED, see “Checking the Battery Status” on page 7.

Understanding the Status LEDs

LED Color Description

Notification Orange The CK3 is notifying you of a pending 
alarm or message.

Good Read Green The CK3 has successfully decoded a bar 
code.

Intermec Ready-to-
Work indicator

Blue The CK3 is suspending or resuming 
with the display turned off.

Blinking blue You have successfully loaded and 
activated Intermec Terminal Emulator. 
Or the Intermec Terminal Emulator 
application is loaded, but is inactive.

Off The Intermec Terminal Emulator 
application is missing or disabled.

Notification LED Battery status LED

Good Read LED and Intermec
Ready-to-Work indicator
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The Intermec Ready-to-Work indicator (blue LED) is used by 
Intermec’s SmartSystems Foundation, an application that lets you 
manage all of your SmartSystems-enabled devices simultaneously 
from a central location. For more information, see “Configuring the 
CK3 Remotely With SmartSystems Foundation” on page 33, or 
contact your Intermec representative. Custom applications may also 
use the blue LED for other purposes.

Scanning Bar Codes
The CK3 ships with an internal imager to scan and enter bar code 
data. You can also connect to:

• cordless scanners, such as the SF51 and SR61 through Bluetooth 
communications. For help, see “Connecting to a Bluetooth 
Scanner” on page 35.

• tethered scanners, such as the SR30 and SR61T through the 
CK3 RS-232 adapter (Model AA21). For help, see the CK3 RS-232 
Adapter (AA21) Instructions.

The type of imager you are using and the type of bar code you are 
decoding determines the way you scan the bar code. Depending on 
the imager model, the CK3 supports reading 1D linear bar codes, 2D 
images, and composite and postal codes. You can identify the imager 
model by looking at the label inside the battery compartment.

By default, these bar code symbologies are enabled on the CK3: 

• Code 39

• Code 128/GS1-128

The blue LED usually turns off within 10 seconds, but it may stay 
on for up to 30 seconds. During this time, do not press the Power 
button  or remove the battery, or you may corrupt the data on 
your CK3.

Note: The CK3 with an EX25 near-far range area imager does not 
support connections to the SR61T.

http://epsfiles.intermec.com/eps_files/eps_man/943-208.pdf
http://epsfiles.intermec.com/eps_files/eps_man/943-208.pdf
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• DataMatrix (area imagers only)

• PDF417 (if supported)

• EAN/UPC

If you are using bar code labels that are encoded in a different 
symbology, you need to enable the symbology on the CK3. Use 
Intermec Settings to enable and disable symbologies. For help, see 
“Using Intermec Settings Directly on the CK3” on page 31.

The next two sections describe how to scan a bar code label with the 
linear imager, area imager, and near-far range area imager.

Scanning With the Linear Imager
If your CK3 has a linear imager, use the following procedure to 
practice scanning a bar code.

To scan bar code labels with the linear imager
1 Press  to turn on the CK3.

2 Point the scanner window at the bar code label and hold the CK3 
at a slight angle 15 to 25 cm (6 to 10 in) from the label.

3 Press the Scan button on the keypad, or pull the trigger on a 
handle, and direct the red beam so that it falls across all bars in the 
bar code label.

Use this test bar code:

Code 39 Test Bar Code

*123456*
*123456*
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When the CK3 successfully reads a bar code label, you hear a high 
beep and the green Good Read LED turns on briefly.

4 Release the Scan button or trigger.

Scanning With an Area Imager
Your CK3 may come with one of two types of area imagers:

• Extended range area imager

• Near-far range area imager

Both area imagers are equipped with a laser pointer and framer to 
help you aim at bar codes, allow you to scan 2D bar code symbologies, 
and support omni-directional (360°) scanning. Omnidirectional 
scanning lets you position the CK3 in any orientation to scan a bar 
code label.

Scanning With the Extended Range Area Imager
1 Press  to turn on the CK3.

2 Point the scanner window at the bar code label, and hold the CK3 
steady a few inches from the label.

3 Press the Scan button or pull the trigger on your scan handle. The 
laser pointer and illumination beam and frame appear. 

Good Read LED

Scan button
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4 Use the laser pointer as a guide and aim toward the middle of the 
bar code. Make sure that the illumination frame covers the bar 
code you are trying to decode.

When the CK3 successfully reads a bar code label, you hear a high 
beep, and the Good Read LED turns on briefly. 

5 Release the Scan button or trigger.

Scanning With the Near-Far Range Area Imager
1 Press  to turn on the CK3.

2 Point the scanner window at the bar code label.

3 Press the Scan button or pull the trigger. The illumination beam 
and laser pointer appear.

• For near or close-in scanning distances of 30 cm (11.8 in) or 
less, use the laser pointer as a guide and aim slightly to the 
right of the center of the bar code. Make sure the illumination 
beam covers the bar code you are trying to decode.

Good Read LED

Scan button

*JOHNB*

*JOHNB*

Laser pointer
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• For standard and long range scanning distances of 30 cm 
(11.8 in) or more, use the laser pointer as a guide and aim 
toward the middle of the bar code. Make sure that the 
illumination beam covers the bar code you are trying to 
decode.

When the CK3 successfully reads a bar code label, you hear a high 
beep, and the Good Read LED turns on briefly. 

4 Release the Scan button or trigger.

Improving the Performance of the Area Imager
If you experience problems scanning a bar code with the 2D imager, 
try these possible solutions:

• Keep your hand as steady as possible while scanning a label.

• Position the imager as close to the bar code as possible while still 
being able to capture the entire bar code.

• Enable only the bar codes that you need to use every day.

• Choose a Predefined mode in Intermec Settings:

a Tap Start > Settings > the System tab > Intermec Settings.

b Tap Data Collection > Internal Scanner > Imager Settings > 
Predefined Modes and then select one of these options:

Predefined Mode Select if You Are Scanning:

1D Only 1D labels.

1D and 2D 
Standard

All types of bar code labels.

1D and 2D Bright 
Environment

In high ambient light, such as outdoors in the 
sunshine.

1D and 2D 
Reflective Surface

Glossy labels.

Custom In conditions that require customized settings. 
For more information about these settings, 
commands, and parameters, see the Intermec 
Settings Command Reference Manual available 
from the Intermec web site at 
www.intermec.com.

http://www.intermec.com
http://epsfiles.intermec.com/eps_files/eps_man/937-016.zip
http://epsfiles.intermec.com/eps_files/eps_man/937-016.zip
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• If you are scanning multiple bar codes in a small area, use one of 
these parameters:

• Aiming beam activation

• Aim triggering mode

• Center decoding

To enable these parameters, use Intermec Settings. For help, see 
“Using Intermec Settings Directly on the CK3” on page 31.

For help scanning using center-decoding, see the next procedure.

To scan a bar code using center-decoding
1 Press  to turn on the CK3.

2 Point the scanner window at the bar code label.

3 Press the Scan button or pull the trigger. The illumination beam 
and the laser pointer appear.

4 Aim both the illumination beam and the laser pointer at the bar 
code you want to scan.

Note: The center-decoding parameter only decodes a bar code if 
the laser pointer is on the bar code and the illumination beam 
covers the bar code.
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When the CK3 successfully reads a bar code label, you hear a high 
beep and the green Good Read LED turns on briefly.

Using a microSD Card
You can use a micro Secure Digital (SD) card to increase file storage 
and install software. Your CK3 supports microSDTM cards that hold 
up to 2 GB of information. The microSD card slot is located in the 
battery compartment.

To install a microSD card
1 Remove the battery. For help, see “Removing and Installing the 

Battery” on page 5.

*JOHNB*
*JOHNB*

*JOHNB*
*JOHNB*

Laser pointer

Good Read LED

Scan button
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2 Use a paper clip or slotted screwdriver to remove the cover.

3 Slide the microSD card cover toward the OPEN position and lift 
the cover.
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4 Insert the microSD card.

5 Close the microSD card cover, and slide the cover toward the 
LOCK position.

6 Replace the cover.

7 Use the stylus to press the reset button in the battery 
compartment of the CK3.

8 Install the battery.

Do not use force or a sharp object when pressing the reset 
button. You may damage the reset button.

Reset button
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9 Press  to turn on the CK3:

• You should be able to navigate to the SDMMC Disk folder and 
see the contents of the microSD card.

• If the microSD card is bootable, your CK3 boots from the card.

• If the microSD card contains operating system upgrade 
files, the upgrade process automatically starts. For more 
information, see “Upgrading the System Software” on 
page 60.

For troubleshooting information, see “Troubleshooting Your CK3” 
on page 67.
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2
Connecting and Configuring the CK3

Use this chapter to understand how to configure the CK3 to 
communicate in your network. This chapter contains these 
topics:

• Managing the CK3 Using SmartSystems Foundation

• Connecting to a PC

• Configuring the CK3 Parameters

• Configuring the CK3 for Your Network

• Configuring Wireless Security
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Managing the CK3 Using SmartSystems 
Foundation

Intermec's SmartSystems™ Foundation is a software platform that 
lets you manage all of your SmartSystems-enabled devices, including 
the CK3, simultaneously from a central server. The SmartSystems 
console displays all SmartSystems-enabled computers and peripherals 
in your network.

Through the console, you can:

• drag-and-drop configuration bundles, operating system updates, 
and firmware upgrades to multiple computers.

• save configuration settings from a single device and deploy those 
settings to many devices simultaneously.

• remotely change settings on SmartSystems-enabled computers 
and peripherals.

The SmartSystems console can report on asset locations and battery 
status, making it easier to manage your mobile devices.

With an AutoDeploy license, SmartSystems can automatically push 
software, configuration settings, and other files to connected CK3s. 
The license also enables Scan-to-Connect, which makes connecting 
additional CK3s to your wireless network as easy as reading bar codes.

SmartSystems Foundation can be downloaded at no charge from the 
Intermec web site. For more information, visit 
www.intermec.com\SmartSystems. To purchase an AutoDeploy 
license, contact your local Intermec sales representative.

Connecting to a PC
You can use Microsoft ActiveSync to establish a connection between 
your CK3 and PC. ActiveSync lets you transfer files, synchronize files, 
remotely debug, and perform other device management activities. 
ActiveSync is a free application available from the Microsoft web site.

http://www.intermec.com/SmartSystems
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To establish an ActiveSync partnership between your CK3 and PC, 
you need to physically connect your CK3 to your PC using these 
accessories:

• AD20 single dock

• USB to mini-USB cable

To establish an ActiveSync partnership
1 Download ActiveSync from the Microsoft web site and install 

ActiveSync on your PC. When installation is complete, the Get 
Connected dialog box appears.

2 Follow the onscreen instructions to establish a partnership. When 
the partnership is established, the Microsoft ActiveSync screen 
appears on your PC.
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Configuring the CK3 Parameters
You can configure many parameters on the CK3 such as the bar code 
symbologies it decodes or the network settings. The values you set for 
these parameters determine how the CK3 operates.

Operating parameters can be viewed and changed on the CK3 by 
using the Intermec Settings application on the computer. There are 
two ways to access Intermec Settings:

• Remotely via Intermec SmartSystems Foundation. When you use 
SmartSystems, you can remotely configure all your CK3 
computers as well as other SmartSystems-enabled Intermec 
computers and peripherals. For more information, see the next 
section.

• Directly on the CK3. Using Intermec Settings on the CK3 changes 
only the settings on that computer. For more information, see 
“Using Intermec Settings Directly on the CK3” on page 31.

• You can use a third-party device management product that 
includes Intermec Settings Configuration Support, such as the 
Microsoft System Center Mobile Device Manager. 
Visit http://www.microsoft.com/systemcenter/mobile for 
more information.

You can also configure the CK3 with configuration bundles that you 
create using SmartSystems Foundation. For more information, see 
the SmartSystems Foundation online Help.

Using Intermec Settings Remotely With SmartSystems 
Foundation

Your CK3 is SmartSystems-enabled, which lets you open Intermec 
Settings from the SmartSystems console to remotely configure all of 
your CK3 computers.

For more information on SmartSystems, see “Managing the CK3 
Using SmartSystems Foundation” on page 28.

To open Intermec Settings from the SmartSystems console
1 In the SmartSystems console, right-click a CK3.

2 Select Intermec Settings.

http://www.microsoft.com/systemcenter/mobile
http://www.microsoft.com/systemcenter/mobile
http://www.microsoft.com/systemcenter/mobile
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3 Change settings as needed. As you choose parameters, information 
on each parameter appears in the upper right pane of the Intermec 
Settings browser.

4 When you are done making changes, choose File > Save Settings.

For help with using Intermec Settings, in the browser click Help > 
Contents.

For information on all parameters in Intermec Settings, see the 
Intermec Settings Command Reference Manual.

Using Intermec Settings Directly on the CK3
Use Intermec Settings on the CK3 to comfigure the computer and 
view system information. 

To open Intermec Settings
• Tap Start > Settings > the System tab > Intermec Settings.

For information about each command, see the Intermec Settings 
Command Reference Manual.

Navigating in Intermec Settings

To Perform 
This Action Do This

Select a command. Tap the command or use the up and down arrow keys.

Expand a command. Tap the command or use the left and right arrow keys.

http://epsfiles.intermec.com/eps_files/eps_man/937-016.zip
http://epsfiles.intermec.com/eps_files/eps_man/937-016.zip
http://epsfiles.intermec.com/eps_files/eps_man/937-016.zip
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Hiding Menu Items in Intermec Settings
In Intermec Settings, you can hide items in the CK3 menus, or in the 
directory tree in the SmartSystems console. Hidden items are not 
saved when you back up your settings in the SmartSystems console.

In Intermec Settings in the SmartSystems console:

• To hide menu items, right-click a menu item and choose Hide 
Menu Item from the popup list. Click Yes to clear the confirming 
message.

• To restore menu items, click the CK3 name at the top of the 
directory tree to select it, and then choose View > Unhide Items. 
All hidden menu items are restored.

In Intermec Settings on the CK3:

• To hide menu items, tap and hold the item, and then choose Hide 
Menu Item from the popup list. Tap Yes to clear the confirming 
message.

• To restore hidden items in a single menu, tap and hold the menu 
bar where the item was hidden, and then choose Restore Item 
Default from the popup list.

• To restore all hidden items in all menus, tap Menu > Unhide All 
Items.

Select text in a text 
box. 

Tap in the text box and drag the stylus over the text.

Save your settings. Tap File > Save Settings or tap .

Navigating in Intermec Settings (continued)

To Perform 
This Action Do This

Note: When you restore default settings in Intermec Settings, only the 
settings for visible items are restored to defaults. The settings for 
hidden menu items are not affected. For more information, see the 
SmartSystems Foundation online Help.
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Configuring the CK3 Remotely With SmartSystems 
Foundation

Intermec’s SmartSystems Foundation lets you manage all of your 
SmartSystems-enabled devices simultaneously from a central 
location. The SmartSystems console displays all of the SmartSystems-
enabled devices in your network. 

Your CK3 is SmartSystems-enabled, which lets you open Intermec 
Settings from the SmartSystems console to remotely configure all of 
your CK3 computers.

To open Intermec Settings from the SmartSystems console
1 In the SmartSystems console, right-click a CK3.

2 Select Intermec Settings.

For more information about SmartSystems Foundation, go to the 
Intermec web site at www.intermec.com/products/
smrtsysfoundation/index.aspx. 

Configuring the CK3 for Your Network
The CK3 is a versatile mobile computer that you can easily add to 
your wireless or wired data collection network. You can connect your 
CK3 using:

• 802.11b/g or 802.11a/b/g radio communications.

• Bluetooth communications.

• Ethernet communications.

• USB and serial communications.

Configuring 802.11 Radio Communications

Your CK3 has an 802.11b/g or 802.11a/b/g radio to transfer data 
using wireless communications. This section assumes that your 
wireless network is set up, including your access points. 

Make sure all components with antennas are at least 30 cm (1 ft) 
apart when power is applied. Failure to comply could result in 
equipment damage.

http://www.intermec.com/SmartSystems
http://www.intermec.com/SmartSystems
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To configure 802.11 radio parameters
1 Tap Start > Settings > the Systems tab >Intermec Settings.

2 Tap Communications > 802.11 Radio > Funk Security > 
[Profile #] > SSID.

3 Enter your SSID (network name).

4 If you are not using DHCP, tap IP Settings and configure your 
network settings.

5 Make sure that your CK3 is talking to the network and that the 
network can see your CK3.

6 Configure security. For help, see “Configuring Wireless 
Security” on page 41.

Configuring Bluetooth Communications
You CK3 is Bluetooth™-enabled, which lets you connect to other 
Bluetooth devices, such as: 

• scanners.

• printers.

• audio devices.

You need to turn on the Bluetooth radio before you can discover and 
connect to other Bluetooth devices. By default, the radio is turned off.

To turn on the Bluetooth radio
1 Tap Start > Settings > the Connections tab > Bluetooth > the 

Mode tab.
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2 Tap Turn on Bluetooth.

3 (Optional) If you want your CK3 to be visible to other Bluetooth 
devices, tap Make this device visible to other devices.

4 Click ok.

The Bluetooth radio maintains its current state through a warm or 
cold boot and maintains virtual COM ports. But, if you clean boot 
your CK3, you need to recreate pairings to devices.

You can also access Bluetooth settings using Intermec Settings. 

To access Bluetooth settings using Intermec Settings
• In Intermec Settings, tap Communications > Bluetooth.

For more information about Bluetooth settings, see the Intermec 
Settings Command Reference Manual.

Connecting to a Bluetooth Scanner
You can connect to an Intermec Bluetooth scanner, such as the SF51 
or SR61, using one of these methods:

• Create and scan a connection configuration label using EasySet.

• Run the Wireless Scanning Wizard.

Note: For both methods, you need the Bluetooth address. The 
Bluetooth address is on the labels located on the outside of the CK3 
shipping box, and on the packet of information that ships with the 
mobile computer.

http://epsfiles.intermec.com/eps_files/eps_man/937-016.zip
http://epsfiles.intermec.com/eps_files/eps_man/937-016.zip
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To create a connection configuration label using EasySet
1 Download EasySet from the Intermec website at 

www.intermec.com. 

2 Click the Products tab.

3 Using the Products page, navigate to your product page. Click 
Computers > Handheld Computers > CK3 > Downloads tab > 
EasySet ver. 5.6.4.2.

4 Follow the instructions to download EasySet.

5 Open EasySet.

6 Select Interface > Bluetooth > Connect/disconnect > Compose 
BT addess:. The Bluetooth - Connect/disconnect - Compose BT 
addess screen appears.

7 Enter the BT address listed on the labels.

8 Click OK.

To connect to a Bluetooth scanner with a connection configuration 
label

1 Make sure that the Bluetooth radio on your CK3 is enabled and 
that your CK3 is visible and connectable.

2 Make sure that your Bluetooth scanner is on.

3 With your Bluetooth scanner, scan the Bluetooth EasySet 
connection configuration label.

4 When prompted, enter the passcode for your scanner. The default 
passcode for Intermec Bluetooth scanners is 0000.

5 Tap Finish.

http://www.intermec.com
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To connect to a Bluetooth scanner with the Wireless Scanning Wizard
1 Select Start > Settings > the System tab > Wireless Scanning.

2 Follow the onscreen instructions to connect to a scanner.

Configuring Bluetooth Communications for Wireless 
Printing
To configure your CK3 for Bluetooth wireless printing, you need to:

• make sure Bluetooth power is on. For help, see the procedure in 
“Configuring Bluetooth Communications” on page 34.

• create an application that opens the wireless printing COM port 
on your CK3. For help, see the Bluetooth Resource Kit, part of the 
Intermec Developer Library (IDL), available from the Intermec 
web site at www.intermec.com/idl.

• select the current wireless printer on the CK3. For help, see the 
next procedure.

http://www.intermec.com/idl
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To select the current wireless printer
1 Select Start > Settings > the System tab > Wireless Printing.

2 Tap Search to find a printer, or tap Manual to enter a device 
address. Follow the onscreen instructions to select the current 
wireless printer.

3 (Optional) Tap Print Test Page. The printer prints out the test 
page.

Connecting to a Bluetooth Audio Device
Use the Bluetooth Audio applet to discover, activate, and connect to 
Bluetooth audio devices such as a Bluetooth headset.

Note: You can also print wirelessly using Microsoft APIs with 
Bluetooth extensions for Winsock and Bluetooth virtual COM ports. 
For help, see the IDL, available from the Intermec web site at 
www.intermec.com/idl.

http://www.intermec.com/idl
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To connect to a Bluetooth audio device
1 Select Start > Settings > the System tab > Bluetooth Audio. The 

Bluetooth Audio screen appears.

2 Follow the onscreen instructions to connect to a Bluetooth audio 
device.

Configuring Ethernet Communications
You connect your CK3 to your Ethernet network with an Ethernet 
cable and one of these accessories:

• AD20 single dock with an AA12 Ethernet adapter

• AD21 Ethernet multidock

To use your CK3 in an Ethernet network
1 Connect your CK3 to an Ethernet network with an AD20 or AD21. 

Ethernet communications is automatically enabled on your CK3.
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2 Configure these network parameters:

• If you have a DHCP server, enable DHCP.

• If you do not have a DHCP server, set these parameters:

a IP address

b Subnet mask

c Default router

3 If necessary, set these parameters:

• Primary and secondary DNS servers

• Primary and secondary WINS servers

4 Make sure that your CK3 is communicating with the network and 
that the network can see your CK3.

Using Serial and USB Communications
You can use these CK3 accessories to transmit data to and receive data 
from another device through serial or USB communications:

• AD20 single dock

• AV10 vehicle dock

• AA21 RS-232 adapter

For more information about these accessories and how to order them, 
see “Accessories” on page 94.

Checking the Status of Your Wireless Connection
After you configure your wireless settings, you can use iConnect to 
check the status of your connection. You can also use iConnect to 
configure the network settings and test the connection of your CK3 
against the network.

To check the status of your wireless connection
1 Tap the iConnect icon ( ) in the lower right corner of the Today 

screen.

2 From the iConnect menu, select Status > Wireless. The Wireless 
Status screen appears and checks the connection.
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To configure the network settings
• From the iConnect menu, tap Tools > Wireless Settings.

To test the connection of your CK3 against your network
• From the iConnect menu, select Tools > Ping Test.

Configuring Wireless Security
The CK3 provides four types of security for your wireless network: 

• Wi-Fi Protected Access 2 (WPA2™)

• Wi-Fi Protected Access (WPA)

• 802.1x

• WEP

This section explains how to configure wireless security on your CK3. 
If you choose not to use security, see “Disabling Security” on 
page 52. Intermec recommends that you always implement security.

You must use either Funk or Microsoft security to implement your 
security solution. For details, see the next section, “Choosing 
Between Funk and Microsoft Security.”

If you are using WPA-802.1x, WPA2-802.1x, or 802.1x security, this 
section also assumes that your authentication server and 
authenticators are properly configured.

Note: Your security choice does not depend on your authentication 
server. For example, you can choose Funk security if you use 
Microsoft Active Directory® to issue certificates.
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Choosing Between Funk and Microsoft Security
The CK3 supports both Funk and Microsoft security. The option you 
choose depends on your network security needs.

Selecting a Funk Security Profile
You can define up to four profiles for Funk security. Different profiles 
let your CK3 communicate in different networks without having to 
change all of your security settings. For example, you may want to set 
up one profile for the manufacturing floor and one for the 
warehouse. By default, the active profile is Profile 1.

To select a Funk security profile
1 Start Intermec Settings.

2 Choose Communications > 802.11 Radio > Funk Security.

Understanding Microsoft and Funk Security

Security Choice Description

Microsoft Microsoft security dynamically selects wireless networks 
based on your preferences. If you are primarily using the 
CK3 to connect to Wi-Fi hotspots, you may want to use 
Microsoft security. 
To use Microsoft security, you need to select it as your 
security choice. For help, see “Selecting Microsoft as 
Your Security Choice” on page 47.

Funk (default) Funk security offers features that are similar to Microsoft 
security, but Funk also offers these features:
• CCX v4.0 compliance
• Support for LEAP and TTLS
• Configuration of up to four profiles
If you are using the CK3 in a static environment that 
requires a high level of security, you should use Funk 
security.
To use Funk security, you need to select a profile. For help, 
see the next section, “Selecting a Funk Security Profile.”

Note: You can also use the Profile Wizard to configure most wireless 
security settings. To start the Profile Wizard, tap the iConnect icon 
( ) in the lower right corner of the Today screen and select Tools > 
Wireless Settings.
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3 Tap a profile to expand it. 

4 (Optional) In the Profile Label text box, enter a meaningful name 
for your profile.

5 Configure your security settings. For help, see the next sections.

6 Repeat Steps 3 through 5 for each profile you want to define.

7 Select one profile as the active profile by tapping Active Profile 
and choosing a profile from the list.

8 Save your settings.

Configuring WPA Security With Funk Security
Use these procedures to set WPA-802.1x, WPA2-802.1x, WPA-PSK, or 
WPA2-PSK security on your CK3 with Funk security.

To configure WPA-802.1x or WPA2-802.1x with Funk security
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Make sure Funk is selected as your security choice.

3 Start Intermec Settings.

4 Choose Communications > 802.11 Radio > Funk Security.

5 Select the profile you want to configure.

6 For Association, choose WPA or WPA2. Encryption 
automatically defaults to TKIP or AES, respectively.

7 For 8021x, choose TTLS, PEAP, EAP-FAST, or TLS and press 
Enter.

8 If you choose TTLS or PEAP:

a For Prompt for Credentials, choose Enter credentials now.

b Tap User Name, enter your user name, and press Enter.

c Tap User Password, enter your password, and press Enter.

Note: You can use Prompt for Credentials to troubleshoot 
your network connection. 



Chapter 2 — Connecting and Configuring the CK3

44 CK3 Mobile Computer User’s Manual

d For Validate Server Certificate, choose Yes and press Enter.

If you choose TLS:

a Load a user and root certificate on your CK3. For help, see 
“Loading a Certificate” on page 50.

b Enter a User Name and Subject Name.

c For Validate Server Certificate, choose Yes and press Enter.

d (Optional) To increase your level of security, enter a Server 1 
Common name and a Server 2 Common name.

9 Save your settings and exit Intermec Settings.

To configure WPA or WPA2 with Funk security
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Make sure Funk is selected as your security choice.

3 Start Intermec Settings.

4 Choose Communications > 802.11 Radio > Funk Security.

5 Select the profile you want to configure.

6 For Association, choose WPA or WPA2 and press Enter.

7 For 8021x, choose None and press Enter.

8 For Pre-Shared Key, enter the pre-shared key or passphrase. 

The pre-shared key must be a value of 32 hex pairs preceded by 0x 
for a total of 66 characters. The value must match the key value on 
the access point. The passphrase must be from 8 to 63 characters. 
After you enter a passphrase, the CK3 internally converts it to a 
pre-shared key.

This value must match the passphrase on the authenticator.

9 Save your settings and exit Intermec Settings.

Note: The correct date must be set on your CK3 when you 
enable Validate Server Certificate.
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Configuring 802.1x Security With Funk Security
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Make sure Funk is selected as your security choice.

3 Start Intermec Settings.

4 Choose Communications > 802.11 Radio > Funk Security.

5 Select the profile you want to configure.

6 For Association, choose Open and press Enter.

7 For Encryption, choose WEP and press Enter.

8 For Authentication, choose TTLS, PEAP, or TLS and press 
Enter.

9 If you choose TTLS or PEAP:

a Tap User Name, enter your user name, and press Enter.

b Tap Password prompt, choose Enter password now, and 
press Enter. 

c Tap User Password, enter your password, and press Enter.

d For Validate Server Certificate, choose Yes and press Enter.

If you choose TLS:

a Load a user and root certificate on your CK3. For help, see 
“Loading a Certificate” on page 50.

b For Validate Server Certificate, choose Yes and press Enter.

c Enter a User Name and Subject Name.

d (Optional) To increase your level of security, enter a Server 1 
Common name and a Server 2 Common name.

10 Save your settings and exit Intermec Settings.

Note: You can use Password prompt to troubleshoot your 
network connection. 
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Configuring LEAP Security on Your CK3
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Make sure Funk is selected as your security choice.

3 Start Intermec Settings.

4 Choose Communications > 802.11 Radio > Funk Security.

5 Select the profile you want to configure.

6 For 8021x, choose LEAP and press Enter.

7 For Association, choose Open, WPA, WPA2, or Network EAP 
and press Enter. Encryption automatically defaults to TKIP if you 
choose WPA, AES if you choose WPA2, and WEP if you choose 
Open or Network EAP.

8 For Prompt for Credentials, choose Enter credentials now.

9 Tap User Name, enter your user name, and press Enter.

10 Tap User Password, enter your password, and press Enter.

11 Save your settings and exit Intermec Settings.

Configuring Static WEP Security With Funk Security
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Make sure Funk is selected as your security choice.

3 Start Intermec Settings.

4 Choose Communications > 802.11 Radio > Funk Security.

5 Select the profile you want to configure.

6 For Association, choose Open and press Enter.

7 For Encryption, choose WEP and press Enter.

8 For 8021x, choose None.

9 Define a value for the keys you want to use. You can define up to 
four keys (Key 1 through Key 4).

Enter an ASCII key or a hex key that is either 5 bytes or 13 bytes 
long depending on the capability of the radio. Set a 5- byte value 
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for 64-bit WEP or a 13-byte value for 128-bit WEP. Hex keys must 
be preceded by 0x and contain 5 or 13 hex pairs.

10 For Transmit key, choose the key you want to use for 
transmitting data.

11 Save your settings and exit Intermec Settings.

Selecting Microsoft as Your Security Choice
The default security setting is Funk. If you want to use Microsoft 
security, you need to select it as your security choice. After you select 
Microsoft as your security choice, you will be prompted to save your 
settings and reset your CK3 for your change to take effect.

With Microsoft as your security choice, you can configure:

• WPA.

• 802.1x.

• Static WEP.

To select Microsoft security as your security choice
1 Select Start > Settings > the System tab > Intermec Settings. The 

Intermec Settings application appears.

2 Select Communications > 802.11 Radio > Security Choice.

3 From the Security Choice list, select Microsoft Security and save 
your settings. An alert box appears telling you that you must save 
your settings and warm boot the CK3 for the new security choice 
to take effect.

4 Tap Yes. The CK3 resets and starts with Microsoft Security as the 
Security Choice.

Configuring WPA Security With Microsoft Security
Use these procedures to set WPA-802.1x and WPA-PSK security on 
your CK3 with Microsoft security.

To enable WPA-802.1x with Microsoft security
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Start Intermec Settings.

3 Choose Communications > 802.11 Radio > Microsoft Security.
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4 For Infrastructure Mode, choose Infrastructure.

5 For Network Authentication, choose WPA. Data Encryption 
automatically defaults to TKIP.

6 For 802.1x Authentication, choose either TLS or PEAP.

7 If you choose TLS:

a Select Properties and tap the Run App button. The Auth. 
Settings dialog box appears.

b Tap the Select button.

c Select your certificate from the list and press Enter. The User 
Logon dialog box appears.

d Enter a User Name and Domain and press Enter.

If you choose PEAP:

a Select Properties and tap the Run App button. The Auth. 
Settings box appears.

b Select Validate Server and press Enter. When the radio starts 
to authenticate, the Network Password dialog box appears.

c Enter a User Name and Password and select Save Password.

d (Optional) In the Domain field, enter the Active Directory 
domain associated with the user account.

e Press Enter.

8 Save your settings and exit Intermec Settings.

To enable WPA-PSK With Microsoft Security
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Start Intermec Settings.

3 Choose Communications > 802.11 Radio > Microsoft Security.

4 For Infrastructure Mode, choose Infrastructure.

5 For Network Authentication, choose WPA-PSK. Data 
Encryption automatically defaults to TKIP.

6 For Pre-Shared Key, enter the pre-shared key or the passphrase.



Chapter 2 — Connecting and Configuring the CK3

CK3 Mobile Computer User’s Manual 49

The pre-shared key must be a value of 32 hex pairs preceded by 
0x for a total of 66 characters. The value must match the key value 
on the authenticator. The passphrase must be from 8 to 63 
characters. After you enter a passphrase, the CK3 internally 
converts it to a pre-shared key.

This value must match the passphrase on the authenticator.

7 Save your settings and exit Intermec Settings.

Configuring 802.1x Security With Microsoft Security
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Start Intermec Settings.

3 Choose Communications > 802.11 Radio > Microsoft Security.

4 For Infrastructure Mode, choose Infrastructure.

5 For Network Authentication, choose Open.

6 For Data Encryption, choose WEP.

7 For 802.1X Authentication, choose TLS or PEAP.

8 If you choose TLS:

a Select Properties and tap the Run App button. The Auth. 
Settings box appears.

b Tap the Select button.

c Select your certificate from the list and press Enter. The User 
Logon dialog box appears.

d Enter a User Name and a Domain. and press Enter.

If you choose PEAP:

a Select Properties and tap the Run App button. The Auth. 
Settings box appears.

b Select Validate Server and press Enter. When the radio starts 
to authenticate, the Network Password dialog box appears.

c Enter a User Name and Password and select Save Password.

d (Optional) In the Domain field, enter the domain.

e Press Enter.
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9 For Network Key Setting, choose Automatic.

10 Save your settings and exit Intermec Settings.

Configuring Static WEP Security With Microsoft Security
1 Make sure the communications and radio parameters on your 

CK3 are configured.

2 Start Intermec Settings.

3 Choose Communications > 802.11 Radio > Microsoft Security.

4 For Network Authentication, choose Open.

5 For Data Encryption, choose WEP.

6 For Network Key Setting, choose Enter Key and Index.

7 For Network Key Value, enter an ASCII key or a hex key that is 
either 5 bytes or 13 bytes long depending on the capability of the 
radio.

Set a 5-byte value for 64-bit WEP or a 13-byte value for 128-bit 
WEP. Hex keys must be preceded by 0x and contain 5 or 13 hex 
pairs.

8 For Network Key Index, select the key you want to use for data 
transmission.

9 Save your settings and exit Intermec Settings.

Loading a Certificate
If you choose to use transport layer security (TLS) with WPA or 802.1x 
security, you need a unique client certificate on the CK3 and a trusted 
root certificate authority (CA) certificate. Certificates are pieces of 
cryptographic data that guarantee a public key is associated with a 
private key. They contain a public key and the entity name that owns 
the key. Each certificate is issued by a certificate authority.

To import a certificate
1 Tap the iConnect icon ( ) in the lower right corner of the Today 

screen. The iConnect pop-up menu appears.

2 Select Tools > Wireless Settings. The Profile Wizard appears.
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3 Tap Edit Selected Profile > the Security tab.

4 For 8021x Security, select PEAP, TLS, or TTLS.

5 Tap Get Certificates.

6 To import a root certificate:

a Tap the <<< button next to the Import Root Certificate field 
to select the root certificate (DER-encoded .cer file) to import.

b Click Import Root Cert to install the selected certificate.

To import a user certificate:

a Tap the <<< button next to the Certificate Path field to select 
the user certificate (DER-encoded .cer file without the private 
key) to import.
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b Tap the <<< button next to the Key Path field to select the 
private key (.pvk file) which corresponds to the user certificate 
you selected.

To import a certificate from an IAS server:

a Tap Web Enrollment.

b Enter the User, Password, and Server (IP address) to log into 
the server.

c Tap OK. A dialog box appears asking if you want to load the 
root certificate.

d Tap OK. The Enrollment Tool message box appears telling you 
that the certificate has been added.

e Tap OK to close the message box.

Disabling Security
If you choose not to use security with your wireless network, you can 
disable it on the CK3. Intermec recommends that you always set 
security in your network.

To disable security
1 Open Intermec Settings.

2 Choose Communications > 802.11 Radio > Microsoft Security.

3 For Network Authentication, choose Open.

4 For Data Encryption, choose Disabled.

5 Close Intermec Settings.
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3
Developing and Installing Applications

This chapter contains guidelines for developing applications 
for the CK3 and contains these sections:

• Developing Applications for the CK3

• Installing Applications on the CK3

• Freeing Up Virtual Memory for Applications

• Launching an Application Automatically

• Upgrading the System Software
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Developing Applications for the CK3
Use the Intermec Resource Kits to develop applications to run on the 
CK3. The Resource Kits are a library of C++, .NET, Java, and web 
components grouped by functionality that you can use to create 
applications for the computer. The Resource Kits are part of the 
Intermec Developer Library (IDL), and can be downloaded from the 
Intermec web site at www.intermec.com/idl. 

For more information, see the Intermec Developer Library Resource 
Kit Developer’s Guide.

Packaging Your Application
For very simple applications, the executable file may be the only file 
you need to deploy. More typically, you will have a set of files to 
install.

Intermec recommends using .cab files to install your applications. 
The CK3 uses standard Windows Mobile .cab files and will install 
third-party .cab files. 

Choosing a Target Location
You can have your .cab file place your application in any of these 
memory locations on the CK3: 

• The ObjectStore.

• The optional microSD card. Depending on available disk space, 
you may want to consider installing your application files on the 
microSD card. Using a card creates the Storage Card folder on the 
CK3.

• The non-volatile Flash File Store. Applications and data in the 
Flash File Store will persist through a clean boot.

Note: The Flash File Store may be erased if you reflash the image.

http://epsfiles.intermec.com/eps_files/eps_man/934-006.pdf
http://epsfiles.intermec.com/eps_files/eps_man/934-006.pdf
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Installing Applications on the CK3
You can install applications on your CK3 by using:

• SmartSystems Foundation.

• Microsoft ActiveSync.

• a microSD card.

• the CK3 FTP server.

For more information on installing applications, see the Intermec 
Developer Library Resource Kit Developer’s Guide.

Installing Applications Using SmartSystems Foundation
You can use the SmartSystems console to drag-and-drop Intermec 
applications onto your CK3. The console is part of SmartSystems 
Foundation. For more information, see “Managing the CK3 Using 
SmartSystems Foundation” on page 28.

To use SmartSystems console to install an application
1 Download your application file from the Intermec web site and 

unzip it on your desktop PC.

2 Double-click the application file to install it. The application file 
should appear in the Software Vault.

3 From the SmartSystems console in the Software Vault, drag-and-
drop the application onto each CK3 in your network, or drop the 
application on a group of CK3s contained in a folder.

You can also use SmartSystems Scan-to-Connect to connect the CK3 
to your network and install software. For more information, see the 
SmartSystems Foundation console online Help.

Installing Applications Using Microsoft ActiveSync
When you only have a few computers to update with applications, you 
can copy files using Microsoft ActiveSync.

This procedure assumes that Microsoft ActiveSync is installed on 
your PC and is up and running. For more information on installing 
and using ActiveSync, see “Connecting to a PC” on page 28.

http://epsfiles.intermec.com/eps_files/eps_man/934-006.pdf
http://epsfiles.intermec.com/eps_files/eps_man/934-006.pdf
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To install an application on the computer using ActiveSync
1 Connect to the CK3 via ActiveSync. For help, see “Connecting to 

a PC” on page 28.

2 Copy the .cab files from your development PC to the CK3.

3 Warm boot or cold boot the CK3.

4 After the boot process is finished, browse to the .cab files and tap 
the files to install them.

Installing Applications Using a Storage Card
For information on installing the microSD card in the CK3, see 
“Using a microSD Card” on page 23.

To install applications using the storage card
1 Copy your application file to the microSD card.

2 Install the microSD card in the CK3.

3 On your CK3, browse to the Storage Card folder and run your 
application.

Installing Applications Using the FTP Server
The CK3 has a built-in FTP server that connects to a network through 
Ethernet, 802.11, or WAN (Wireless Access Network). You can use the 
server to transfer your application file to the computer. Because you 
can create FTP scripts to automate the process of copying files to the 
computer, this option is useful when you need to send files to a large 
number of computers.

The easiest way to manage the FTP server is to enable the FTP menu 
within iConnect.

To enable the FTP menu
• Create this DWORD registry key and set it to a value of 1:

HKEY_CURRENT_USER\Software\iConnect2\IConnect\Settings\ShowFTPMenu

The iFTP menu is available the next time you start iConnect.
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To manage the state of the FTP server
• Modify these existing registry keys:

HKEY_CURRENT_USER\Software\iConnect2\IConnect\Settings\FtpAutoStart
HKEY_CURRENT_USER\Software\iConnect2\IConnect\Settings\FtpHeartbeat

where 1 = enable and 0 = disable.

Freeing Up Virtual Memory for Applications
You can use the InstallSelect application to free up virtual memory 
and create more space to load and run custom applications. 

When you free up virtual memory, you reduce the amount of virtual 
memory used by portions of the SmartSystems Platform Bundle 
(SSPB) by removing value-added software features. Be sure to back up 
any related files that you want before you use the InstallSelect 
application. For more information on SSPB, see “Upgrading the 
System Software” on page 60.

To free up virtual memory
1 Go to Start > Programs > File Explorer.

2 Tap the arrow next to My Documents and select My Device.

3 Tap the Windows folder and scroll down to find InstallSelect.

4 Tap InstallSelect. The Install Select application starts and 
displays a Caution message box.

Note: InstallSelect is designed for use only by administrators, 
developers, integrators, or Intermec service representatives. Do not 
run InstallSelect while using any other applications.

Removing software features may result in loss of computer 
functionality or the ability to manage device settings. Contact 
your Intermec service representative for information about each 
software feature before making changes.
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5 Tap OK to close the box.

6 Clear the check box of any components you do not want installed 
after a clean boot. For a description of each component, see the 
next table.

By default, components already installed on the computer are 
automatically checked to be installed again after you perform a 
clean boot.

7 Tap Apply to initiate the clean boot and install only the files that 
are selected.

8 Tap Yes to continue with the clean boot. The computer performs a 
clean boot and restarts with all of the checked components 
installed.

InstallSelect Software Components

Component Name Description

Data Collection & 
Intermec Settings

Data collection and Intermec Settings. Also includes 
on-unit SDK libraries.
If you disable this .cab file, you cannot scan or collect 
data on the device and you cannot use Intermec 
Settings.

Funk Wireless 
Security

Intermec security supplicant that provides a wireless 
security solution with several features that are not 
supported by Microsoft.

Printer Support Provides Intermec printer driver support.
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Depending on the options you selected for your CK3, you may see 
other components available from the InstallSelect application.

Launching an Application Automatically
There are two ways to automatically launch your application when 
you perform a reset on the computer:

• Make sure your .cab file places a shortcut to your application in 
the \Windows\StartUp folder.

• Configure AutoRun.exe to launch your application.

AutoRun.exe automates operations on your CK3. You can configure 
AutoRun.exe through the AutoRun data file (AutoRun.dat). For 
compatibility with other Intermec computers, you can place a copy of 
AutoRun.exe in the same folder as your AutoRun.dat file.

To create and install the AutoRun.dat file on your computer
1 Create a folder called System on your CK3.

2 On your PC, open the Notepad application.

3 Write commands for AutoRun.dat using the supported AutoRun 
script commands. For help, see the next table.

4 Save the Notepad file as AutoRun.dat.

5 Copy the AutoRun.dat file to the System folder on your CK3. 
During every boot, the system scans for AutoRun.dat in the 
System folder.

Intermec DHCP 
Client 

Provides the Intermec DHCP client application.

Bluetooth Provides the Intermec Bluetooth application support.

Avalanche Enabler Enables the client to the Wavelink Device Management 
solution.

InstallSelect Software Components (continued)

Component Name Description
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AutoRun supports the following script commands in AutoRun.dat.

AutoRun handles quoted file names for the first parameter, which 
allows you to specify path names or file names that contain white 
spaces. AutoRun only supports one set of quotes per command.

Upgrading the System Software
When you upgrade your computer, you are updating the operating 
system (OS) and the SmartSystems Platform Bundle (SSPB) files.

The SSPB files are stored on the DiskOnChip and deliver Intermec 
Value Add (IVA) functionality such as data collection, configuration, 
the Intermec wireless security suite, and SmartSystems Foundation. 
As new features are added to these components, you can upgrade your 
SSPB files without needing to upgrade the operating system. 
Alternately, you can choose to upgrade only the operating system if 
you need new functionality. If you upgrade the operating system, you 
will need to reinstall SSPB files.

There are two ways to upgrade your computer:

• You can upgrade your computer using a storage card. For help, see 
the next section, “Upgrading the CK3 Using a microSD Card.”

• You can upgrade your computer using the SmartSystems Console. 
For help, see “Upgrading the CK3 Using SmartSystems 
Foundation” on page 62.

You need to download the latest upgrade files from the Intermec web 
site to your PC.

AutoRun Script Commands

Command Description

EXEC Launches a specified program and waits for it to finish (up to 10 
minutes).

CALL Processes a specified file of commands and returns.

CHAIN Processes a specified file of commands and does not return.

RUN Loads and runs a specified program.

LOAD Loads and runs a specified program.
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To download the upgrade files
1 Start your web browser and go to the Intermec web site at 

www.intermec.com.

2 Go to Support > Downloads.

3 Click the link to search the product downloads.

4 Select your computer from the Downloads list. The Downloads 
page displays all of the downloads available for your computer.

5 Download the upgrade file you need. If you want to upgrade both 
the OS and the SSPB, you will need to download both files.

Upgrading the CK3 Using a microSD Card
To use a microSD card to upgrade the computer, you need an SD card 
reader and a microSD adapter card formatted as FAT16.

To upgrade the operating system using a microSD card
1 Insert a microSD card into a microSD adapter card and then place 

it in the storage card reader connected to your PC.

2 Copy all required OS upgrade files to the microSD card.

3 Remove the battery by pressing the release button.

4 Remove the microSD card from the adapter card and insert it into 
the CK3.

5 Place the CK3 with the battery removed, in a dock connected to 
external power and press the Reset button (using a stylus) located 
in the battery cavity on the back of the CK3. For help, see “Cold 
Booting the CK3” on page 77.

6 Remove the microSD card when the Installation Complete menu 
appears.

7 Remove the CK3 from the dock and replace the battery.

To upgrade the SSPB using a microSD card
1 Insert a microSD card into a microSD adapter card and then place 

it in the storage card reader connected to your PC.

2 Copy all required SSPB upgrade files to the microSD card.

3 Remove the microSD card from the adapter card and insert it into 
the CK3.

http://www.intermec.com
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4 Using the stylus, press the Reset button in the battery 
compartment.

5 Press and hold  as you insert the battery back into the CK3.

6 Continue to hold  until a Warning message appears.

7 Release , read the message, and press either button on the right 
side to continue.

8 Perform the screen alignment and wait for the CK3 to load files 
from the microSD card. 

When the progress is complete, the CK3 warm boots to reset the 
configuration.

9 Remove the microSD card and delete the files.

10 Set the date, time, and network communication parameters to 
reestablish communications with the other devices in the wireless 
network.

Upgrading the CK3 Using SmartSystems Foundation
You can use the SmartSystems console to upgrade the operating 
system on your CK3. The console is part of SmartSystems Foundation 
and is available from the Intermec web site through the Intermec 
Developer Library (IDL). Before you can upgrade your CK3, you need:

• SmartSystems Foundation. To download SmartSystems 
Foundation, go to www.intermec.com/idl and open the Device 
Management page.

• the device upgrade .exe file. This file is available from the Intermec 
web site at www.intermec.com. Go to Support > Downloads. 
Make sure the file you select is for your language.

To upgrade the computer using SmartSystems Foundation
1 Install SmartSystems Foundation on your PC and open the 

SmartSystems console.

2 Make sure the SmartSystems console and CK3 are on the same 
subnet.

3 Make sure your CK3 is either in a communications dock or 
charging dock or the device power management is disabled.

4 Download the device upgrade .exe file to your PC.

http://www.intermec.com/idl
http://www.intermec.com
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5 Double-click the .exe file on your PC. An InstallShield application 
starts and walks you through the process of extracting the 
upgrade files to the default location.

6 From the SmartSystems console, locate the device upgrade to 
install.

7 Drag the application to each CK3 you want to upgrade or to a 
group of CK3s in a folder.The SmartSystems console installs the 
upgrade on your computers.

After the download is complete, your CK3 replaces the operating 
system and automatically performs a cold boot.

Note: Do not change the default location where InstallShield 
extracts the files. The SmartSystems console requires the files to 
be in this location.

Note: The SmartSystems console indicates that your CK3 is offline, 
by displaying a red stop sign symbol, until the CK3 reboots and 
reconnects to the system.
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4
Troubleshooting and Maintaining the CK3

This chapter contains possible solutions to problems you may 
encounter while using the CK3. This chapter also contains 
information on booting the computer and these topics:

• Calling Product Support

• Troubleshooting Your CK3

• Resetting the CK3

• Cleaning the Scanner Window and Screen
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Calling Product Support
If you cannot find the answer to your problem in “Troubleshooting 
Your CK3” on page 67, you can visit the Intermec technical 
knowledge base (Knowledge Central) at intermec.custhelp.com to 
review technical information or to request technical support. If you 
still need help after visiting Knowledge Central, you may need to call 
Product Support.

To talk to an Intermec Product Support representative, call

1-800-755-5505.

Before you call Intermec Product Support, make sure you have the 
following information ready:

• Serial number

• Configuration number

• Operating system version

• SmartSystems Platform Bundle (SSPB) version

• If you are using security, know the type (Funk or Microsoft) and 
the full set of parameters

• Power management settings

• If you are using Intermec Terminal Emulation (ITE), know the 
version and protocol

• If you are not using ITE, know the language your custom 
application was written in and the tools you used to create it

You can find most of the information listed above in Intermec 
Settings. Consult your application developer for information on your 
custom application.

To find your configuration number
• Look at the CN field of the configuration label on the back of your 

CK3.

http://intermec.custhelp.com
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To find your operating system version
1 Tap Start > Internet Explorer.

2 Tap the Intermec logo. The Intermec page appears and displays 
the version of the operating system and the SmartSystems 
Platform Bundle (SSPB) loaded on your CK3.

Troubleshooting Your CK3
Use this section to troubleshoot some common problems you may 
experience with your CK3. 

Note: If you send the CK3 in for service, it is your responsibility to 
save the computer data and configuration. Intermec is responsible 
only for ensuring that the hardware matches the original 
configuration when repairing or replacing the computer.

Problems While Configuring the CK3

Problem Possible Solution

You scan a 
configuration 
command, such as 
Beeper Volume, and 
you hear three low 
beeps and nothing 
happens.

If you are working in Intermec Settings, you cannot 
scan configuration commands. Exit the application 
to scan configuration commands.
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You scan or enter 
an option for the 
Scanner Model 
configuration 
command, and you 
hear three low beeps 
and nothing 
happens.

You may have scanned or entered a Scanner Model 
command that does not apply to the type of scanner 
that you have installed. Try scanning or entering the 
Scanner Model command again and select an option 
for the type of device you are using.

You cannot type a 
character on the 
keypad or you can 
only type uppercase 
or lowercase letters.

You may have locked a modifier key on the keypad. 
Press the necessary key sequence to unlock the key. 
For help, see “Using the Keypad” on page 8.

You press  and 
nothing happens.

• Make sure the backlight is on.
• Make sure you have a charged battery that is 

installed correctly. For help, see “Charging the 
Battery” on page 5.

• The battery may be discharged. Replace the battery 
with a spare charged battery, or charge the battery.

• Reset the CK3. For help, see “Resetting the CK3” 
on page 77.

You insert a 
microSD card and 
cannot find the 
SDMMC Disk folder 
on the CK3. Or, you 
insert a bootable SD 
card and the CK3 
does not boot from 
the card.

• The microSD card may not be installed correctly. 
Insert the microSD card as described in Steps 2 
through 4 of “Using a microSD Card” on 
page 23. 

• The microSD card may be damaged. Try another 
microSD card.

The Battery status 
LED is on.

• If the battery status LED is a steady green, the 
battery is more than 95% charged and computer is 
on a charger.

• If the battery status LED is blinking red, then the 
battery is low. Replace or charge the battery.

• If the battery status LED is a steady red, the main 
battery is on charge.

Problems While Configuring the CK3 (continued)

Problem Possible Solution
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The computer 
appears to be locked 
up and you cannot 
enter data.

• Press the power key to turn off the CK3, and then 
press the power key again to turn it on.

• Press and hold the power key 5 seconds to warm 
boot the CK3.

• Try reloading the firmware. For help, see 
“Upgrading the System Software” on page 60.

• If the CK3 does not boot or reset, contact your 
Intermec representative for help.

You tap the screen 
and nothing 
happens.

Align your screen. For help, see “Aligning the Touch 
Screen” on page 15.

Problems With Wireless Connectivity

Problem Possible Solution

When you turn on 
the CK3 after it was 
suspended for 10 to 
15 minutes or 
longer, the CK3 can 
no longer send or 
receive messages over 
the network.

The host may have deactivated or lost the current 
terminal emulation session. In a TCP/IP direct 
connect network, turn off the “Keep Alive” message 
from host to maintain the TCP session while the 
computer is suspended.

The CK3 is 
connected to the 
network, and you 
move to a new site to 
collect data. Now, 
your CK3 is not 
connected to the 
network.

Move closer to an access point or to a different 
location to reestablish communications until you 
reconnect with the network. Any data collected while 
out of range is transmitted over the network.

The CK3 appears to 
be connected to the 
network, but you 
cannot establish a 
terminal emulation 
session with the host 
computer.

There may be a problem with the host computer, with 
the connection between the Intermec Application 
Server and the host computer, or with the connection 
between the access point and the host computer. 
Check with network administrator to make sure the 
host is running and allowing users to login to the 
system.

Problems While Configuring the CK3 (continued)

Problem Possible Solution
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The CK3 appears to 
be connected to the 
network, but the 
host computer is not 
receiving any 
information from 
the CK3.

There may be a problem with the connection between 
the access point and the host computer. Check with 
network administrator or use your access point user’s 
manual.

Problems While Configuring 802.1x Security

Problem Possible Solution

The CK3 
indicates that 
it is authenticated, 
but it does not 
communicate with 
the host.

Make sure the CK3 IP address, host IP address, subnet 
mask, default router are configured for the network.

The CK3 does 
not appear to be 
authenticating and a 
network connection 
icon does not appear 
on the toolbar.

• The CK3 may not be communicating with the 
access point. Make sure the CK3 network name 
matches the access point network name (SSID). 

• The 802.1x security network may not be active. 
Make sure the server software is properly loaded 
and configured on the server PC. See server 
software documentation for help.

A network 
connection icon 
appears in the 
toolbar, but then 
disappears.

• The CK3 may not be communicating with the 
intended access point. Make sure the CK3 network 
name matches the access point network name. 
Default network name is “INTERMEC.”

• The access point may not be communicating with 
the server. Ensure the access point is turned on, 
properly configured, and has 802.1x security 
enabled.

You are setting up 
multiple access 
points in a network, 
with different SSIDs, 
and the connection 
fails.

When you change the SSID, the WEP key values are 
not saved. Configure the WEP key values and save 
your changes. 

Problems With Wireless Connectivity (continued)

Problem Possible Solution
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The CK3 
indicates it is not 
authenticated.

Make sure that:
• the User Name and Password parameters on the 

CK3 match the user name and password on the 
authentication server. You may need to configure 
the password on both the CK3 and the 
authentication server.

• on your authentication server, the user and group 
are allowed and the group policy is allowed to log 
into the server. For help, see the documentation 
that shipped with your authentication server 
software.

• the IP address and secret key for the access point 
match the IP address and secret key on the 
authentication server. You may need to configure 
the IP address and secret key on both your access 
point and authentication server.

• the authentication server software is running on 
the server PC.

You clean boot 
the CK3 and this 
message appears, 
“The server 
certificate has 
expired or your 
system date is 
incorrect.”

When you clean boot the CK3, the date and time are 
not saved. Configure the date and time and save your 
changes.

Problems While Scanning Bar Codes

Problem Possible Solution

You press the Scan 
button, but you 
cannot see a red 
beam of light.

• You may be too far away from the bar code label. 
Try moving closer to the bar code label and scan it 
again.

• You may be scanning the bar code label “straight 
on.” Change the scanning angle and try again.

• •Move within two feet of a wall to test the effective 
scan of the scanner. For help scanning bar codes, 
see “Scanning Bar Codes” on page 17.

Problems While Configuring 802.1x Security (continued)

Problem Possible Solution



Chapter 4 — Troubleshooting and Maintaining the CK3

72 CK3 Mobile Computer User’s Manual

The input device 
attached to the CK3 
does not work well 
or read bar code 
labels very quickly.

Set the Scanner Model command to the specific 
attached input device. Check enabled bar code 
symbologies and enable only the symbologies being 
used.

When you release 
Scan button, the 
Good Read LED 
does not turn off.

If the CK3 is configured to use continuous/edge 
triggering, the Good Read LED stays on.
If the CK3 is configured to use level triggering, there 
may be a problem. Press the Scan button or pull the 
trigger again without scanning a bar code label. If the 
LED is still on, contact your local Intermec 
representative.

The scanner does not 
read the bar code 
label.

• Aim the scanning beam so that it crosses the entire 
bar code label in one pass. Try changing the scan 
angle.

• Check the quality of the bar code label, Scan a bar 
code label that you know scans well. Compare the 
two bar code labels to see if the bar code quality is 
too low. You may need to replace the label that you 
cannot scan.

• Make sure the bar code symbology is enabled. For 
help, see “Using Intermec Settings Directly on 
the CK3” on page 31.

• Make sure the application is accepting input by 
scanning a bar code. You may need to type this 
information instead.

The scanner does not 
read the bar code 
labels quickly, or the 
scanning beam 
seems to be faint or 
obscured.

The scanner window may be dirty. Clean the window 
with a solution of ammonia and water. Wipe dry. Do 
not allow abrasive material to touch the window.

The scanned bar 
code data that 
appears in your 
application does 
not match the data 
encoded in the bar 
code label.

The CK3 may have decoded the bar code label in a 
different bar code symbology. Try scanning the bar 
code label again. Make sure you scan the entire label.

Problems While Scanning Bar Codes (continued)

Problem Possible Solution
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Checking 802.11 Network Status
If you have trouble connecting to your 802.11 wireless network:

• Make sure you have correctly set network parameters on the CK3.

• Check your wireless security settings.

Follow the next procedure to use iConnect to verify available access 
points and networks, check signal strength, and view other 
diagnostics. If you need to contact Intermec Product Support, this 
information can be helpful in troubleshooting wireless network 
connection issues.

To use iConnect to verify network status
1 Tap the iConnect icon ( ) in the lower right corner of the CK3 

screen.

2 Choose Status > Wireless.

3 Tap Advanced. The diagnostics screen appears.

The ISpy tab shows:

• the MAC address and IP address of the 802.11 radio.

• network association status, including the SSID and MAC 
address of the access point

• security configuration.

• radio transmit power and signal strength information.
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4 Tap the Scan tab to view a list of available 802.11 networks. The 
list includes the signal strength, channel, and MAC address for 
each network.

• Tap Scan to refresh the screen.

5 Tap the Supp tab to view radio supplicant information, including 
a list of supplicant events and authentication status.

• To verify the settings for the currently active security profile, 
tap Configure Profile. The Profile Wizard for the active 
profile appears.

• To try reconnecting to the network, tap Reconnect.

• To delete the events in the list, tap Clear Events.
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6 Tap the Ping tab to run a ping test to the host.

To run a ping test:

a In the Host field, enter the IP address of the host.

b From the Repetitions list, choose the number of times the 
CK3 will ping the host.

c Tap Ping. The graph shows the amount of time it takes for the 
host to return the ping. Tap List to see this information in a 
list format.

7 Tap the RSSI tab to view the received signal strength of the host 
signal.

The information box includes the current signal strength, host 
SSID name, MAC address, data rate, and transmit power.
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• Tap Mark to place an arrow marker above the graph.

8 Tap the Conf tab to set up a log file that lists RSSI history.

This screen includes the 802.11 radio driver version and available 
radio modes.

To create a log file:

a Check the Log to File check box.

b (Optional) Change the sample period and number of samples 
displayed.

c Tap Log File. The Save As screen appears.

d (Optional) Change the name of the saved log file, the folder to 
which the file will be saved, the content type (log or text), and 
the location.

e Tap Save.
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Resetting the CK3
You seldom need to reset the CK3. However, you do need to reset the 
CK3 when an application is locked up and does not respond, when 
you upgrade the firmware, or when you reflash the CK3. The CK3 
uses the configuration currently saved in flash memory during the 
reset process. 

There are three ways to reset the CK3:

• Warm boot

• Cold boot

• Clean boot

Warm Booting the CK3
If your CK3 has a charged battery installed but does not resume after 
you press the Power key, or if the computer or an application is locked 
up, you may need to warm boot the CK3.

To warm boot your CK3
• Press and hold  for 5 seconds.

Or,

• From the SmartSystems console, right-click the CK3 and select 
Intermec Power Tools > Warm Boot Device.

The CK3 shuts down, restarts, and goes through the initialization 
process.

Cold Booting the CK3
If the CK3 or application is locked up and does not respond to a warm 
boot, follow this procedure to perform a cold boot. 

Performing a cold boot may result in data loss. When you 
cold boot the CK3, cached disk data may not be saved, so 
transactional data may be lost. 
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To cold boot your CK3
1 Press and hold  for about 2 seconds to suspend the CK3.

2 Remove the battery.

3 Use the stylus to press the reset button in the battery 
compartment of the CK3.

4 Replace the battery.

Clean Booting the CK3
If the CK3 does not warm boot or cold boot, you may need to perform 
a clean boot. When you clean boot the CK3, the CK3 only loads files 
and applications that are absolutely required by the operating system. 
Perform a clean boot to get the CK3 up and running so that you can 
run diagnostic tests to troubleshoot the normal boot process.

Reset button

Do not use force or a sharp object when pressing the reset 
button. You may damage the reset button.

The clean boot process erases the CK3 memory, including all 
applications and data files in the object store. To preserve 
applications through a clean boot, store them in the Flash File 
Store. For more information, see “Installing Applications on the 
CK3” on page 55.
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To clean boot the CK3
1 Press and hold  for about 2 seconds to suspend the CK3.

2 Remove the battery.

3 Use the stylus to press the reset button in the battery 
compartment of the CK3.

4 Replace the battery.

5 Press and hold both  and the PTT button.

6 Continue to hold  and PTT until the “Clean boot the system?” 
prompt appears on screen.

7 Release the two buttons, read the message, and press the 
appropriate button to either proceed with the clean boot or cancel 
the clean boot.

Reset button

Note: You can also clean boot your CK3 from the SmartSystems 
console: right-click the CK3 and select Intermec Power Tools > 
Clean Boot Device.
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Cleaning the Scanner Window and Screen
To keep the CK3 in good working order, you may need to perform 
these minor maintenance tasks:

• Clean the scanner window.

• Clean the CK3 screen.

Clean the scanner window and CK3 screen as often as needed for the 
environment in which you are using the computer. To clean the CK3, 
use a solution of ammonia and water. 

To clean the scanner window and computer screen
1 Press  to turn off the CK3.

2 Dip a clean towel or rag in the ammonia solution and wring out 
the excess. Wipe off the scanner window and screen. Do not allow 
any abrasive material to touch these surfaces.

3 Wipe dry.

There are no user-serviceable parts inside the CK3. Opening the 
unit will void the warranty and may cause damage to the internal 
components.
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Physical and Environmental Specifications
Physical Dimensions
Length: 21.69 cm (8.54 in)

Width (at widest part): 8.36 cm (3.29 in)

Height (at tallest part): 4.67 cm (1.84 in)

Power and Electrical Specifications
Operating: Rechargeable lithium-ion battery

Backup: Supercap supplies 10 minutes of bridge
time while replacing the main battery

Electrical rating: x 4,4 V, 2A; x 4,7 V, 1,5A

Temperature and Humidity Specifications
Operating temperature: -10°C to 50°C (14°F to 122°F)

Storage temperature: -20°C to 70°C (-4°F to 158°F)

Charging temperature: 0°C to 45°C (32°F to 113°F)

Relative humidity (operating): 0 to 95% non-condensing

Environmental rating: IP54

Screen Specifications
• 240 RGB x 320 pixels

• 8.9 cm (3.52 in) diagonal square active area, ¼ VGA

• LED backlight with 5 levels of brightness

CK3 Weight

Scan Engine Option With AB17 With AB18

With EV12 14.41 oz 16.32 oz

With EA20X 14.74 oz 16.66 oz

With EX25 15.73 oz 17.64 oz
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LCD capable of both portrait and landscape operationKeypad 
Options
• Alphanumeric and function keypad

• Numeric and function keypad

• Large numeric and limited function keypad

Bar Code Symbologies

* These symbologies are only available if your CK3 has an extended 
range area imager or a near-far range area imager.

• Australian Post* • GS1 DataBar Omnidirectional

• Aztec* • Info Mail

• BPO (British Post 4-state)* • Interleaved 2 of 5

• China Post • Japan Post*

• Canada Post • Matrix 2 of 5

• Codabar • Maxicode*

• Codablock A • Micro PDF417*

• Codablock F • MSI

• Code 11 • PDF417*

• Code 39 • Planet*

• Code 93 • Plessey

• Code 128/GS1-128 • Postnet*

• DataMatrix* • QR Code*

• Dutch Post* • Standard 2 of 5

• EAN/UPC • Swedish Post

• GS1 Composite* • Telepen

• GS1 DataBar Expanded • TLC 39

• GS1 DataBar Limited
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EV12 Linear Imager Reading Distances

EV12 Linear Imager Minimum Reading Distances: This graphic does not 
include the 0.12 cm (0.05 in) setback for the CK3.

Minimum Reading Distances With 0.12 cm (0.05 in) Setback*

Symbology Density Minimum Distance Maximum Distance

Code 39 0.15 mm (6 mils)
0.25 mm (10 mils)
0.5 mm (20 mils)
1 mm (40 mils)

9.6 cm (3.8 in)
7.1 cm (2.9 in)
6.1 cm (2.5 in)
8.1 cm (3.2 in)

17.9 cm (7.1 in)
20.9 cm (8.3 in)
26.9 cm (10.6 in)
33.9 cm (13.4 in)

EAN/UPC 0.33 mm (13 mils) 6.1 cm (2.5 in) 22.9 cm (9.1 in)

*Minimum reading distances are measured in the dark (0 lux).
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EV12 Linear Imager Typical Reading Distances: This graphic does not include 
the 0.12 cm (0.05 in) setback for the CK3.

Typical Reading Distances With 0.12 cm (0.05 in) Setback*

Symbology Density Minimum Distance Maximum Distance

Code 39 0.15 mm (6 mils)
0.25 mm (10 mils)
0.5 mm (20 mils)
1 mm (40 mils)

9.1 cm (3.6 in)
6.1 cm (2.5 in)
5.1 cm (2.1 in)
7.1 cm (2.9 in)**

19.9 cm (7.9 in)
24.9 cm (9.8 in)
34.9 cm (13.8 in)
50.9 cm (20.1 in)

EAN/UPC 0.33 mm (13 mils) 5.1 cm (2.1 in) 27.9 cm (11.0 in)

* Typical reading distances are measured in an office environment (200 lux).
** Minimum distance depends on bar code width and scan angle.
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EA20X Extended Range Area Imager Minimum Reading 
Distances

Minimum Reading Distances With 0.2 cm (0.08 in) Setback*

Symbology Density Minimum Distance Maximum Distance

Code 39 0.15 mm (6 mils)
0.20 mm (8mils)
0.25 mm (10 mils)
0.50 mm (20 mils)
1.00 mm (40 mils)

16.2 cm (6.4 in)
12.2 cm (4.8 in)
9.2 cm (3.6 in)
10.2 cm (4.0 in)
15.2 cm (6.1 in)

21.8 cm (8.6 in)
30.8 cm (12.1 in)
40.8 cm (16.0 in)
70.8 cm (27.9 in)
99.8 cm (39.3 in)

EAN/UPC 
100%

0.33 mm (13 mils) 9.2 cm (3.6 in) 47.8 cm (18.8 in)

Data Matrix 0.18 mm (7 mils)
0.25 mm (10 mils)
0.38 mm (15 mils)

17.2 cm (6.8 in)
15.2 cm (6.1 in)
10.2 cm (4.0 in)

19.8 cm (7.8 in)
28.8 cm (11.3 in)
44.8 cm (17.6 in)

PDF417 0.17 mm (6.6 mils)
0.25 mm (10 mils)
0.38 mm (15 mils)

15.2 cm (6.1 in)
10.2 cm (3.9 in)
11.2 cm (4.4 in)

21.8 cm (8.6 in)
32.8 cm (12.9 in)
49.8 cm (19.6 in)

*Minimum reading distances are measured in the dark (0 lux).
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EA20X Extended Range Area Imager Minimum Reading Distances: This 
graphic does not include the 0.2 cm (0.08 in) setback for the CK3.
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EX25B Near-Far Range Area Imager Reading Distances

EX25B Near-Far Range Imager 1D Minimum Reading Distances: This graphic 
does not include the 0.24 cm (0.09 in) setback for the CK3.

1D Symbologies Minimum Reading Distances With 0.24 cm (0.09 in) 
Setback*

Symbology Density Minimum Distance Maximum Distance

Code 39 0.1 mm (3.8 mils)
0.25 mm (10 mils)
0.5 mm (20 mils)
1 mm (40 mils)
1.3 mm (51 mils)
2.5 mm (100 mils)

18.24 cm (7.18 in)
18.24 cm (7.18 in)
19.24 cm (7.57 in)
40.24 cm (15.84 in)
100.24 cm (39.46 in)
130.24 cm (51.27 in)

31.76 cm (12.51 in)
68.76 cm (27.07 in)
109.76 cm (43.22 in)
219.76 cm (86.52 in)
309.76 cm (121.96 in)
429.76 cm (169.20 in)

EAN 100% 0.33 mm 22.24 cm (7.96 in) 99.76 cm (39.28 in)

* Minimum reading distances are measured in the dark (0 lux).
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EX25B Near-Far Range Imager 1D Typical Reading Distances: This graphic 
does not include the 0.24 cm (0.09 in) setback for the CK3.

1D Symbologies Typical Reading Distances With 0.24 cm (0.09 in) 
Setback*

Symbology Density Minimum Distance Maximum Distance

Code 39 0.25 mm (10 mils)
0.5 mm (20 mils)
1 mm (40 mils)
1.4 mm (55 mils)
2.5 mm (100 mils)

16.24 cm (6.21 in)
18.24 cm (7.00 in)
18.24 cm (7.00 in)**
20.24 cm (7.78 in)**
20.24 cm (7.78 in)**

89.76 cm (35.34 in)
179.76 cm (70.77 in)
389.76 cm (153.45 in)
479.76 cm (188.89 in)
869.76 cm (342.43 in)

EAN 100% 0.33 mm 20.24 cm (7.78 in) 109.76 cm (43.22 in)

* Typical reading distances are measured in an office environment (200 lux).
** as long as the bar code label fits in the reading area
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EX25B Near-Far Range Imager 2D Typical Reading Distances: This graphic 
does not include the 0.24 cm (0.09 in) setback for the CK3.

2D Symbologies Typical Reading Distances With 0.24 cm (0.09 in) 
Setback*

Symbology Density Minimum Distance Maximum Distance

DataMatrix 0.25 mm (10 mils)
1.4 mm (55 mils)
2.5 mm (100 mils)
3.5 mm (140 mils)
5 mm (200 mils)

20.24 cm (7.96 in)**
20.24 cm (7.96 in)**
20.24 cm (7.96 in)**
20.24 cm (7.96 in)**
20.24 cm (7.96 in)**

73.76 cm (29.04 in)
339.76 cm (133.77 in)
679.76 cm (267.63 in)
789.76 cm (310.93 in)
1199.76 cm (472.02 in)

* Typical reading distances are measured in an office environment (200 lux).
** as long as the bar code label fits in the reading area
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EX25C Near-Far Range Area Imager Reading Distance

EX25C Near-Far Range Imager 1D Minimum Reading Distances: This graphic 
does not include the 0.24 cm (0.09 in) setback for the CK3.

1D Symbologies Minimum Reading Distances With 0.24 cm (0.09 in) 
Setback*

Symbology Density Minimum Distance Maximum Distance

Code 39 0.08 mm (3 mils)
0.1 mm (2.8 mils)
0.25 mm (10 mils)
0.5 (20 mils)
1 mm (40 mils)
1.3 mm (51 mils)

15 cm (5.91 in)
15 cm (5.91 in)
15 cm (5.91 in)
16 cm (6.30 in)
25 cm (9.84 in)
40 cm (15.75 in)

35 cm (13.78 in)
45 cm (17.72 in)
115 cm (45.28 in)
210 cm (82.68 in)
310 cm (122.05 in)
310 cm (165.35 in)

EAN 100% 0.33 mm 15 cm (5.91 in) 145 cm (57.09 in)

* Minimum reading distances are measured in the dark (0 lux).
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EX25C Near-Far Range Imager 1D Typical Reading Distances: This graphic 
does not include the 0.24 cm (0.09 in) setback for the CK3.

1D Symbologies Typical Reading Distances With 0.24 cm (0.09 in) 
Setback*

Symbology Density Minimum Distance Maximum Distance

Code 39 0.25 mm (10 mils)
0.5 mm (20 mils)
1 mm (40 mils)
1.4 mm (55 mils)
2.5 mm (100 mils)

15 cm (5.91 in)
16 cm (6.30 in)
25 cm (9.84 in)
40 cm (15.75 in)
**

135 cm (53.15 in)
280 cm (110.24 in)
550 cm (216.54 in)
720 cm (283.46 in)
1200 cm (472.44 in)

Code 128 
retro-
reflective

2.5 mm (100 mils) ** 1300 cm (511.81 in)

EAN 100% 0.33 mm 15 cm (5.91 in) 160 cm (62.99 in)

* Typical reading distances are measured in an office environment (200 lux).
** Minimum distance depends on bar code width and scan angle.

32”

in

0 100

cm

160

80

0

80

160

240

320

320

240

400

400

0” 40” 80”

0.25 mm
10 mils

0.5 mm/20 mils

1 mm/40 mils

200 300 600400 700500 1100

120” 160” 200”

64”

0”

32”

64”

800 900 1000

240” 280” 320” 360” 400” 440”

96”

128”

160”

96”

128”

160”

100% EAN 
contrast UPC

480”

1200

2.5 mm/100 mils



Appendix A — Specifications

CK3 Mobile Computer User’s Manual 93

EX25C Near-Far Range Imager 2D Typical Reading Distances: This graphic 
does not include the 0.24 cm (0.09 in) setback for the CK3.

2D Symbologies Typical Reading Distances With 0.24 cm (0.09 in) 
Setback*

Symbology Density Minimum Distance Maximum Distance

DataMatrix 0.25 mm (10 mils)
0.76 mm (30 mils)
1.4 mm (55 mils)
2.5 mm (100 mils)

15 cm (5.91 in)
25 cm (9.84 in)
**
**

90 cm (35.43 in)
310 cm (122.05 in)
450 cm (177.17 in)
1100 cm (433.07 in)

* Typical reading distances are measured in an office environment (200 lux).
** Minimum distance depends on bar code width and scan angle.
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Accessories
You can use these accessories (sold and ordered separately) with 
the CK3. To order accessories, contact your local Intermec sales 
representative.

Battery (AB17, AB18)
The AB17 standard battery and AB18 extended battery provide main 
power to the CK3.

Quad Charger (AC20)
The AC20 quad charger charges up to four CK3 batteries at one time.

Single Dock (AD20)
The AD20 single dock powers your CK3 Mobile Computer and 
charges a spare battery (AB17 or AB18) separately. The single dock 
also provides a two-wire serial debug port and client and host USB 
connectivity.

Ethernet Multidock (AD21)
The AD21 Ethernet multidock provides Ethernet connectivity and 
power to up to four CK3 computers at one time.

Charge-Only Multidock (AD22)
The AD22 charge-only multidock charges up to four CK3 computers 
at one time.

Vehicle Dock (AV10)
Use the AV10 vehicle dock to hold and charge your CK3 while you are 
using it on a vehicle.

Vehicle Battery Adapter (AE33)
Use the AE33 vehicle battery adapter to provide power to your CK3 
from your vehicle. To use the vehicle battery adapter, you also need 
the AA23 power adapter.

Audio Adapter (AA20)
Use the audio adapter to connect an audio device, such as a headset, 
to your CK3.

RS-232 Adapter (AA21)
Use the RS-232 adapter to connect RS-232 devices to your CK3.
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Power Adapter (AA23)
Use the power adapter to provide power to your CK3 from an external 
power supply.

Scan Handle
The scan handle provides you with an alternate way to hold the CK3 
and scan bar code labels using a convenient scanning trigger.

Vehicle Holder
Use the vehicle holder to store your CK3 when you are not using it.

Holster
The holster provides you with a convenient way to carry your CK3 
when you are not using it.

IP30 and SR61 Battery Pack Adapter
The IP30 and SR61 battery pack adapter lets you charge an AB3 
battery using the CK3 quad charger (AC20) or CK3 single dock 
(AD20).

CK3 With IP30 Vehicle Holder
If you attached an IP30 to your CK3, you can use the vehicle holder to 
store your CK3 when you are not using it.
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Default Configuration
The following tables list the default values of the configuration 
commands supported on the CK3. If you restore the CK3to factory 
default settings, the CK3 uses these values.

The commands are grouped by function and reflect the organization 
of Intermec Settings. For detailed information on most of the 
commands, see the Intermec Settings Command Reference Manual, 
available from the Intermec web site at www.intermec.com.

Data Collection

Data Collection Settings

Data Collection Setting Default Value

Enable Scanner Port Enable

Enable Scanner Auto-Detect Enable

Scanner Port Baud Rate 38400

Symbology Settings

Symbology Default Value

Australian Post Disable

Aztec Disable

BPO Disable

Canada Post Disable

China Post Disable

Codabar Disable

Codablock A Disable

Codablock F Disable

Code 11 Disable

Code 39 Enable

Code 93 Disable

Code 128/GS1-128 Enable

DataMatrix Enable

Dutch Post Disable

http://www.intermec.com
http://epsfiles.intermec.com/eps_files/eps_man/937-016.zip
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EAN/UPC Enable UPC A, UPC E, 
EAN 8, EAN 13

GS1 Composite Disable

GS1 DataBar Expanded Disable

GS1 DataBar Limited Disable

GS1 DataBar Omnidirectional Disable

Info Mail Disable

Interleaved 2 of 5 Disable

Japan Post Disable

Matrix 2 of 5 Disable

Maxicode Disable

Micro PDF417 Disable

MSI Disable

PDF417 Enable

Planet Disable

Plessey Disable

Postnet Disable

QR Code Disable

Standard 2 of 5 Disable

Swedish Post Disable

Telepen Disable

TLC 39 Disable

Symbology Option Settings

Symbology Option Default Value

Preamble None (disabled)

Postamble None (disabled)

Global Symbology ID Disable

Symbology Settings (continued)

Symbology Default Value
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RFID

Scanner Settings

Scanner Setting Default Value

Hardware trigger Enable

Turn Off After Good Read Enable/One-shot

Trigger mode (area imagers only) Level

Imager Settings

Imager Setting Default Value

Predefined Modes 1D and 2D Standard

Sticky Aimer LED duration 0 (disabled)

Signature Image Capture Disable

Decode Security Settings

Decode Security Setting Default Value

Consecutive Data Validation 0

Identical Consecutive Timeout 300 ms

Different Consecutive Timeout 0

Center Decoding Disable

Center Decoding Tolerance Disable

Virtual Wedge Settings

Virtual Wedge Setting Default Value

Virtual Wedge Enable

Grid Null

RFID Settings

RFID Setting Default Value

Enable RFID Service Enable
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Application Connection Settings

Application Connection Setting Default Value

Allow External BRI Connections Enable

BRI TCP Port 2189

Enable Logging Disable

Reader 1 Settings

Reader 1 Setting Default Value

Enable Reader Disable

Reader Model IP30

RFID Module Settings

RFID Module Setting Default Value

Tag Type EPC Class 1 Gen2

Dense Reader Mode Disable

LBT Channel 5

LBT Scan Enable Enable

Field Separator Space ()

ID Report Enable

No Tag Report Disable

Report Timeout 0 ms

Timeout Mode Disable

ID Timeout 100 ms

Antenna Timeout 10 ms

ID Tries 3

Antenna Tries 3

Read Tries 3

Write Tries 3

Initialization Tries 1

Lock Tries 3

Select Tries 1

Unselect Tries 1
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Communications

Initial Q 4

Field Strength dB 30

Session 2

Enable Antenna Port 1 Enable

Enable Antenna Port 2 Disable

Enable Antenna Port 3 Disable

Enable Antenna Port 4 Disable

Bluetooth Power Off 300 s

Communications Settings

Communications Setting Default Value

Device Name IntermecCK3

Bluetooth Settings

Bluetooth Setting Default Value

Bluetooth Power Off

Bluetooth Discoverable Disable

Bluetooth Connectable Disable

802.11 Radio Settings

802.11 Radio Setting Default Value

Security Choice Funk Security

Allow Security Changes Enable

Radio Measurement 0

Radio Enabled Enable

RFID Module Settings (continued)

RFID Module Setting Default Value
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Funk Security Settings

Funk Security Setting Default Value

Active Profile 1

Profile Label Profile_1

Network Type Infrastructure

Channel 3

SSID INTERMEC

Power Mode Enabled (Fast PSP)

8021x None

Association Open

Encryption None

Pre-Shared Key Null

Transmit Key Key1

Prompt for Credentials Enable

User Name anonymous

User Password anonymous

Inner Authentication-TTLS MS-Chapv2

Anonymous name anonymous

Inner EAP EAP/MDS

Inner Authentication-PEAP EAP/MS-Chapv2

Subject Name Null

Validate Server Certificate No

Server 1 Common Name Null

Server 2 Common Name Null

Mixed Cell Off

CCKM Off

Automatic PAC Provisioning Off

Provisioning PAC Prompt Off

Reprovisioning PAC Prompt Off

PACManager Null

Logging Off

Radio Measurement 0

Radio Enabled Enable
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Ethernet Adapter Settings

IP Settings Default Value

DHCP Enable

DHCP Client Identifier Null

Primary DNS 0.0.0.0

Secondary DNS 0.0.0.0

Primary WINS 0.0.0.0

Secondary WINS 0.0.0.0

Certificates Settings

Certificates Setting Default Value

Import Root Certificates False

Import User Certificates False

Import Pac Files False

Ethernet Adapter IP Settings

Ethernet Adapter IP Setting Default Value

DHCP Enable

DHCP Client Identifier Null

Primary DNS Null

Secondary DNS Null

Primary WINS Null

Secondary WINS Null

PSK Settings

PSK Setting Default Value

Remote Connection
Host IP
Host Port

0.0.0.0
5555
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Device Settings

Serial Port
Baud
Parity
Data Bits
Stop Bits
Flow Control
Protocol
EOM1
EOM2
SOM
Reader Command
LRC
Handshake

115200
Even
7 Data Bits
1 Stop Bit
No Flow Control
Configurable
\x03
\xFFFFFFFF
\x02
Enable w/o TMF
Disable
Disable

Device Settings

Device Setting Default Value

Date Null

Time Null

Adjust for Daylight Time Disable

Good Read Beep One Beep

Good Read LED On

Beeper Volume Medium

Display Settings

Display Setting Default Value

Backlight on Battery Power
Backlight Turns Off After
Backlight On Tap

30 s
Enable

Backlight on External Power
Backlight Turns Off After
Backlight On Tap

1 min
Enable

Backlight Level High

Screen Rotation 0 degrees

PSK Settings (continued)

PSK Setting Default Value
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Device Monitor

Core Messaging Service

Keypad Settings

Keypad Setting Default Value

Scan Button Remapping for Handle Trigger BRI

Scan Button Remapping for Middle Scan Button Scanner

Power Management Settings

Power Management Setting Default Value

Battery Power 
Device Turns Off After
Screen Turns Off After

2 min
1 min

External Power 
Device Turns Off After
Screen Turns Off After

Disable
Disable

Device Monitor Settings

Device Monitor Setting Default Value

Poll Period 1 min

Threshold Values
Backup Battery Charge Remaining
Main Battery Charge Remaining
Storage Load
Memory Load

10
10
90
90

Core Messaging Service Settings

Core Messaging Service Setting Default Value

Associated Server IP Null

Server Name INTERMEC

Keep Alive Ping Interval 30 s
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Standard Characters
Use the following tables to learn how to enter standard and other 
available characters and functions with the keypad. If there is no 
sequence of keystrokes for a particular character or function, it is only 
available through the soft input panel (SIP), which can be accessed by 
tapping the keyboard icon on the touch screen.

Alphanumeric Characters

Character
Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad

a  

b  

c  

d  

e  

f  

g  

h  

i  

j  

k  

l  

m   

n  

o  

p  

q  

r  

s  

t  

u  

v  

w  

x  
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y  

z  

A      

B      

C      

D      

E      

F      

G      

H      

I      

J      

K      

L      

M      

N      

O      

P      

Q      

R      

S      

T      

U      

V      

W      

X      

Y      

Z      

0

1

2

Alphanumeric Characters (continued)

Character
Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad
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3

4

5

6

7

8

9

Function Keys

Function
Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad

F1

F2

F3

F4

F5

F6  

F7  

F8  

F9  

F10  

F11  

F12  

F13   

F14   

F15   

F16   

F17   

F18   

F19   

Alphanumeric Characters (continued)

Character
Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad
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F20   

F21   

F22   

F23   

F24   

Special Functions

Function
Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad

Forward Tab

Back Tab    

Space    

Backspace

Shift    

Caps Lock    

Field Exit

Up Arrow   

Down Arrow   

Left Arrow   

Right Arrow   

Control   

Alt   

Function Keys (continued)

Function
Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad

Note: Depending on your CK3 model, some of the following 
characters or functions will not be printed on the keypad.

Other Available Characters and Functions

Character or 
Function

Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad

!       
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@       

#       

$       

%       

^       

&       

*       

(       

)       

OEM Down   

CR Select   

Select   

Zoom   

_     [Enter]  

|       [Enter]

:     

?     

;   

/   

-   [Enter]

\   [Enter]

=  SIP

‘  SIP

+  SIP  [Action]

[  SIP

.  SIP

]  SIP

,  SIP

‘  SIP

“  SIP

Volume Down   

Other Available Characters and Functions (continued)

Character or 
Function

Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad
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Windows Menu   ~

OK   k

Volume Up   

Soft Key 1   (

Soft Key 2   )

Other Available Characters and Functions (continued)

Character or 
Function

Alphanumeric 
Keypad Numeric Keypad

Large Numeric 
28-Key Keypad

Note: The following ITE functions are only operational when you are 
using the ITE application. The large numeric 28-key keypad does not 
support ITE.

Intermec Terminal Emulation (ITE) Functions 

Character or Function Alphanumeric Keypad Numeric Keypad

Field Exit

System Request   

Home   

Attention   

Reset   

Clear   

Roll Down   

Previous Screen   

Roll Up   

Next Screen   

Page Left   

Page Up   

Page Down   

Page Right   

Field +   

Field -   
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Index
Numerics
802.11 radio communications, 

configuring 33
802.11d standard, described 3
802.1x security

configuring with Funk 45
configuring with Microsoft 49

A
AA20 audio adapter, described 94
AA21 RS-232 adapter, described 94
AA23 power adapter, described 95
AB17 and AB18 battery, described 

94
AB3 battery, charging with the IP30 

and SR61 battery pack 
adapter 95

AC20 quad charger
charging times 5
described 94

accessories, described 94
ActiveSync

connecting to a PC 28
using to install applications 55

AD20 single dock
charging times 5
described 94

AD21 Ethernet multidock
charging times 5
described 94

AD22 charge-only multidock
charging times 5
described 94

adjusting the speaker volume 12
AE33 vehicle battery adapter, 

described 94
aligning the touch screen 15
alphanumeric keypad. See keypad.
applications

developing
packaging 54
target location on CK3 54

installing
ActiveSync 55
FTP server 56
miniSD card 56

launching automatically 59
area imager

reading distances 86, 88, 91
scanning bar codes 19–21

association label, connecting to a 
Bluetooth scanner 35

audio adapter, AA20, described 94
audio device, Bluetooth, 

connecting to 38
audio recordings, creating using 

the PTT key 12
AutoRun

script commands 60
using to launch other processes 

60
AV10 vehicle dock

charging times 5
described 94

B
backlight settings, configuring 11
backup power, battery 4
bar code symbologies

default settings 98
enabled by default 17
supported 83

battery
AB17 and AB18, described 94
backup power 4
battery icons, described 7
charging times 5
checking the status 7
described 4
installing 5
maximizing battery life 6
removing 5
status LED 7

battery pack adapter, IP30 and 
SR61, described 95

Bluetooth
audio device, connecting to 38
printer, connecting to 37
scanner

connecting to 35
passcode, default 36

Bluetooth Audio applet, described 
38

Bluetooth radio
communications, configuring 

34
turning on 34

booting
clean 78
cold 77
troubleshooting 71
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Index
booting (continued)
warm 77

C
calibrating screen 15
calling product support 66
capitalizing characters 10
caps lock, enabling and disabling 

10
card, microSD, using to install 

applications 56
center-decoding, scanning bar 

codes 22
certificates

IAS server, importing from 52
loading 50
root, importing 51

characters
capitalizing 10
entering with keystrokes 108

charging the battery 5
cigarette lighter adapter. See vehicle 

battery adapter.
CK3 features 2
clean booting

described 78
troubleshooting 71

cold booting, described 77
color-coded keys, using 9
communications

802.11, configuring 33
Bluetooth, configuring 34
Ethernet, configuring 39
serial, using 40
troubleshooting wireless 

network 73
USB using 40

configuration
default settings 98–106
number, finding 66

configuring
backlight settings 11
network communications 33
remotely with SmartSystems 

Foundation 33
configuring the CK3

Intermec Settings 30–32
SmartSystems console 30

connecting to a PC 28
console 30
contacting Intermec by phone xi

D
default

bar code symbologies 17
configuration 98–106

E
EA20X

performance, improving 21
reading distances 86
scanning bar codes 19

environmental specifications 82
errors, finding and solving 67–72
Ethernet communications, 

configuring 39
EV12

reading distances 84
scanning bar codes 18

EX25B
performance, improving 21
reading distances 88

EX25C
performance, improving 21
reading distances 91

extended range area imager
performance, improving 21
reading distances 86
scanning bar codes 19

F
features of the CK3 2
FTP server, using to install 

applications 56
Funk security

choosing 42
configuring

802.1x 45
LEAP 46
WEP 46
WPA 44
WPA2 44
WPA2-802.1x 43
WPA-802.1x 43

described 42
selecting a profile 42

G
green key, using 9
H
handle, scan, described 95
hidden characters, typing 111
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Index
holder, vehicle
described 95
for CK3 with IP30, described 95

holster, described 95

I
IAS server, certificate, importing 52
iConnect

enabling FTP server 56
icon, illustrated 15
wireless connection, checking 

status 40
icons

battery, described 7
screen, described 14

IDL (Intermec Developer Library) 
54

imager, area
center-decoding 22
extended range reading 

distances 86
near-far range reading distances 

88, 91
performance, improving 21
predefined modes 21
scanning bar codes 19–21

imager, linear
reading distances 84
scanning bar codes 18

installing the battery 5
InstallSelect

software components, described 
58

using to free up memory 57
Intermec

contact information ii
product support

calling 66
Knowledge Central web site xi

support contact information xi
Intermec Developer Library (IDL) 

54
Intermec Settings

configuring CK3 31
described 30
menu items, hiding 32
navigating 31
restoring menu items 32
SmartSystems console, opening 

from 30

IP30 and CK3 vehicle holder, 
described 95

IP30 and SR61
battery pack adapter, described 

95
IVA, described 60

K
keypad

capitalizing characters 10
color-coded keys, using 9
hidden characters, typing 111
illustrated 8
keystrokes for entering 

characters 108
options 83
troubleshooting 68
using the color-coded keys 9

Knowledge Central web site 66

L
large numeric keypad. See keypad.
launching applications 

automatically 59
LEAP security, configuring with 

Funk 46
LEDs, status

described 16
illustrated 16

linear imager
reading distances 84
scanning bar codes 18

loading certificates 50
locked computer, troubleshooting 

69

M
manuals, downloading from web 

xii
maximizing battery life 6
memory

freeing up virtual for 
applications 57

installing applications in 54
microSD card

installing 23
troubleshooting 68
upgrading CK3 61
using to install applications 56
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Index
Microsoft security
choosing 47
configuring 47–50

802.1x 49
WEP 50
WPA 47
WPA-802.1x 47
WPA-PSK 48

described 42
modifier keys, using 9
multidock

charge-only, AD22, described 94
Ethernet, AD21, described 94

N
near-far range area imager

reading distances 88, 91
scanning bar codes 20

network
communications, configuring 

33
connection icon

illustrated 14
troubleshooting 70

numeric keypad. See keypad.

O
Object Store, storing applications 

54
omnidirectional scanning 19
operating system

upgrading 60
version, finding 67

orange key, using 9
P
partnership, ActiveSync, 

establishing 28
passcode, Bluetooth scanner 

default 36
patents, list of xiii
PC, connecting to with ActiveSync 

28
PEAP

choosing with 802.1x Funk 
security 45

choosing with 802.1x Microsoft 
security 49

choosing with WPA Funk 
security 43

choosing with WPA Microsoft 
security 48

persistent storage manager, 
upgrading 60

physical specifications 82
power adapter, AA23, described 95
power button

described 11
troubleshooting 68

printer, Bluetooth, connecting to 
37

problems, troubleshooting 67–72
product support

calling 66
Knowledge Central web site xi, 

66
profile, Funk security, selecting 42
PTT (Push To Talk), described

 12

Q
quad charger, AC20, described 94

R
radio

802.11 communications, 
configuring 33

Bluetooth
turning on 34

Bluetooth communications, 
configuring 34

reading distances
EA20X 86
EV12 84
EX25B 88
EX25C 91

recording audio, using the PTT key 
12

removing the battery 5
resetting the CK3 77
root certificate, importing 51
RS-232 adapter, AA21, described 94

S
safety icons x
scan handle, described 95
scanner window, cleaning 80
scanners

Bluetooth
connecting to 35
passcode, default 36

supported 17
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Index
scanning
center decoding 22
omnidirectionally 19
troubleshooting 71, 72

Scan-to-Connect 28
screen

aligning 15
cleaning 80
icons, described 14
specifications 82
touch, described 13
troubleshooting 69

SD card. See microSD card.
SDMMC Disk folder 

troubleshooting 68
security

choosing between Microsoft and 
Funk 42

configuring 41–50
Funk 42–47
Microsoft 47–50

disabling 52
Funk, selecting a profile 42
loading certificates 50

serial communications, using 40
settings

configuring
remotely with SmartSystems 

Foundation 33
default 98–106

single dock, AD20, described 94
SmartSystems Foundation 28

applications, installing 55
AutoDeploy 28
configuring CK3 remotely 33
Intermec Settings, using from 

console 30
Platform Bundle

finding version 67
upgrading with microSD card 

61
Scan-to-Connect 28
upgrading the CK3 62
where to download 28

snap-on adapter
AA20 audio adapter, described 

94
AA21 RS-232 adapter, described 

94
AA23 power adapter, described 

95

software
version, finding 67

speaker, adjusting the volume 12
specifications

physical and environmental 82
screen 82

status LEDs
battery, described 7
described 16
illustrated 16

storage, increasing with microSD 
card 23

support, contacting Intermec xi
suspend mode, described 11
symbologies. See bar code 

symbologies.

T
technical support xi
TLS

choosing with 802.1x Microsoft 
security 49

choosing with WPA Funk 
security 44, 45

choosing with WPA Microsoft 
security 48

touch screen. See screen.
troubleshooting problems 67–72
TTLS

choosing with 802.1x Funk 
security 45

choosing with WPA Funk 
security 43

U
uninstalling the battery 5
upgrade files, downloading 61
upgrading

operating system 60
persistant storage manager 60
using microSD card 61
using SmartSystems console 62

USB communications, using 40

V
vehicle battery adapter, AE33, 

described 94
vehicle dock, AV10, described 94
vehicle holder

described 95
for CK3 with IP30, described 95

virtual memory, freeing up 57
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Index
volume
adjusting 12
icon, illustrated 14

W
warm booting, described 77
warranty information x
WEP security

configuring, Funk 46
configuring, Microsoft 50

WiFi communications
configuring 33
supported 2

will not boot from microSD card 68
window, scanner, cleaning 80
wireless

audio device, connecting to 38
connection, check status with 

iConnect 40
printer, connecting to 38
scanner, connecting to 35

security, configuring 41
Wireless Scanning Wizard, 

connecting to a scanner 35
WPA security

configuring Funk 44
configuring with Microsoft 47

WPA2 security, configuring with 
Funk 44

WPA2-802.1x security, configuring 
with Funk 43

WPA-802.1x security
configuring with Funk 43
configuring with Microsoft 47

WPA-PSK security, configuring 
with Microsoft 48

www.intermec.com
Intermec Developer Library 54
Knowledge Central 66
Product Support 66
SmartSystems Foundation 28
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